CHAPTER 9: TOOLS

I. RECLASSIFY AND SWEEP WORDS

A. Overview ................................................................. 9:1
   What is the purpose of the Reclassify and Sweep Words function? ........................................... 9:1
   How does Reclassify and Sweep update the Word Search list? .................................................. 9:1
   Do I need special security rights to run Reclassify and Sweep? ................................................. 9:1

B. Running Reclassify and Sweep Words .................................................................................. 9:1
   When do I need to run the Reclassify and Sweep function? ........................................................ 9:1
   How do I run Reclassify and Sweep Words? ................................................................................ 9:2
   Can I reclassify and sweep a specific group of records? .............................................................. 9:3

C. Word Search List ............................................................................................................. 9:3
   Can I see a list of the words in my Word Search list? ................................................................. 9:3
   Is every word that I enter kept in my Word Search list? .............................................................. 9:3
   How can I view the excluded words list? ..................................................................................... 9:4
   How do I add or delete words in the excluded words list? ............................................................ 9:4
   Can I print the excluded word list? ................................................................................................ 9:4

D. Analyze Sweep Tables ................................................................................................... 9:4
   What is the Analyze Sweep Tables tool? ..................................................................................... 9:4
   How do I know if I need to use the Analyze Sweep Tables tool? ................................................ 9:5
   How do I run the Analyze Sweep Tables tool? ........................................................................... 9:5

II. BACKUP DATA

A. Overview ..................................................................................................................... 9:7
   Does ICMS include a backup utility? .......................................................................................... 9:7
   How does the Backup Data utility work? .................................................................................... 9:7
   Do I need special security rights to use the Backup Data utility? .............................................. 9:7
   Why should I back up my ICMS data? ...................................................................................... 9:7
   How often should I back up my ICMS data? .............................................................................. 9:8
   Where should I store my ICMS data backup media? ................................................................. 9:8
   How should I back up my ICMS data? ...................................................................................... 9:8
   Why must I use the ICMS Backup Data utility to submit my museum records to WASO and the National Catalog (NPS only)? ................................................................. 9:8

B. Using the Data Backup.................................................................................................. 9:8
   How do I access the Backup Data utility? .................................................................................. 9:8
   What are the available backup options? .................................................................................... 9:9
   What are the steps to run a backup? .......................................................................................... 9:10
   Are there options to restore my data from a backup? ............................................................... 9:10
   How will I be able to distinguish between my backups if they have the same name? .......... 9:10

C. Complete System Backup ............................................................................................ 9:10
   What is the Complete System Backup option? ......................................................................... 9:10
   How do I run the Complete System backup option? ............................................................... 9:11

D. All Databases (data only) ............................................................................................ 9:11
   What is the All Databases backup option? .............................................................................. 9:11
   How do I run the All Databases backup option? ..................................................................... 9:11
III. RESTORE FULL SYSTEM BACKUP

A. Overview .......................................................... 9:21
- What is the Restore Full System Backup utility? .......................................................... 9:21
- Why would I need to restore a full system backup? .......................................................... 9:21
- How does the Restore Full System Backup utility work? .................................................. 9:21
- Do I need special security rights to use the Restore Full System Backup utility? .............. 9:21

B. Using the Restore Full System Backup ................................................................. 9:21
- How do I access the Restore Full System Backup utility? .............................................. 9:21
- How do I use the Restore Full System Backup? ................................................................. 9:22
- How do I move ICMS to a new computer? ......................................................................... 9:23

IV. CREATE NEW DIRECTORY

A. Overview .......................................................... 9:25
- What is the Create New Directory function? ................................................................. 9:25
- Do I need special security rights to create a new directory? ........................................... 9:25
- When would I use the Create New Directory function? ................................................. 9:25
- Why would I need to add a directory? ............................................................................. 9:25

B. Creating a New Directory .......................................................... 9:25
- How do I access the Create New Directory function? ................................................. 9:25
How do I create a new NPS directory? ................................................................. 9:26
What is the Use BOR, DOI, or NPS Center Model Directory option? ......................... 9:27
How do I create a new BOR directory? .................................................................. 9:27
How do I create a new DOI directory? .................................................................. 9:28

V. DELETE A DIRECTORY

A. Overview .................................................................................................................. 9:30
   What is the Delete a Directory function? ................................................................. 9:30
   What kind of directories can I delete? ...................................................................... 9:30
   Do I need special security rights to delete a directory? ........................................... 9:30
   When would I use the Delete a Directory function? ................................................ 9:30

B. Deleting a Directory ................................................................................................ 9:30
   How do I access the Delete a Directory function? .................................................. 9:30
   How do I delete a directory? .................................................................................... 9:30

VI. USER SECURITY

A. Overview .................................................................................................................. 9:34
   Does ICMS include a security system? ..................................................................... 9:34
   What is a User ID? ..................................................................................................... 9:34
   What is a password? .................................................................................................. 9:34
   Where do I get a User ID and password? .................................................................. 9:34
   Can I use my Windows network login to access ICMS? .......................................... 9:34
   What are user security rights? ................................................................................... 9:34
   What do I need to assign User IDs, passwords, and security rights? ...................... 9:34
   How do I assign User IDs and passwords? ............................................................... 9:35
   Can I print a report of all User IDs in my system? .................................................... 9:35
   Can I view the user activity in my system? ............................................................... 9:35
   Can I track changes to records made by users? ....................................................... 9:35

B. User Security ........................................................................................................... 9:35
   How do I access the User Security .......................................................................... 9:35
   How do I view the security information for a user? .................................................. 9:35
   What user information is available on the Main Information tab? ............................ 9:36
   How do I go to the User Security Information tab? ................................................... 9:36
   What information is available on the User Security Information tab? ....................... 9:36
   What are the General Rights available and what do they allow me to do? ............... 9:36
   What are the Specific Rights available and what do they allow me to do? ............... 9:38
   What are Groups and Functions? ............................................................................. 9:38
   What is the Advanced Module Permissions tab? ....................................................... 9:38

C. Adding a User ........................................................................................................... 9:39
   How do I add a new user? ......................................................................................... 9:39
   What is the Use default permissions for selected general right option? ..................... 9:42
   What is the Using Advanced Module Permissions? ............................................... 9:42
   How do I get to the Advanced Module Permissions? ............................................. 9:42
   How do I save the new user? .................................................................................... 9:42

D. Viewing, Modifying and Removing Users ............................................................... 9:42
   How do I view a list of all users? .............................................................................. 9:42
   How do I see the full name and security rights for a specific user? ......................... 9:42
   How do I change the security information for an existing user? .............................. 9:42
   How do I remove a user from ICMS? ....................................................................... 9:43
   Can I view a user's password if they have forgotten it? ........................................... 9:43
E. Directory Level Security .................................................................................................................. 9:43
   Is there additional security available at the directory level? .......................................................... 9:43
   What is the purpose of security at the directory level? .................................................................. 9:43
   Should I adjust users’ rights for a specific directory? ................................................................. 9:43
   Do directory security rights override global security rights? ....................................................... 9:43
   How do I create separate security rights for individual directories? ............................................. 9:44
   How can I tell in which directories a user has directory-specific rights? ...................................... 9:44
   How do I view the directory specific rights? .................................................................................. 9:44
   How can I change the directory specific information for a user? ................................................ 9:44
   How do I remove the directory-specific security for a user? ....................................................... 9:45

F. Additional Questions About User Security .................................................................................... 9:45
   Can I add a user to ICMS and not check any of the security rights boxes? .................................. 9:45
   Should our unit keep the general User ID and general password that comes with ICMS? ............ 9:45
   Should the system administrator routinely work in ICMS with full security rights? ...................... 9:46
   What if I lose my password and am unable to get into ICMS? .................................................... 9:46

G. User Security Profile Report ........................................................................................................ 9:46
   What is the User Security Profile Report? .................................................................................... 9:46
   How do I run the User Security Profile Report? ....................................................................... 9:46

H. Manage User Log .......................................................................................................................... 9:47
   What is the Manage User Log tool? .............................................................................................. 9:47
   How do I access the Manage User Log feature? .......................................................................... 9:47
   What information is available in the User Log? .......................................................................... 9:48
   Can I print the User Log? ............................................................................................................ 9:49
   What is the Purge function? ......................................................................................................... 9:49
   Why would I want to purge the user log? .................................................................................... 9:49
   How do I purge the user log? ....................................................................................................... 9:49
   How do I exit the Manage User Log window? .............................................................................. 9:49

I. Audit Trail Report .......................................................................................................................... 9:49
   What is the Audit Trail feature? ................................................................................................. 9:49
   What information is recorded by the Audit Trail? ........................................................................ 9:49
   Who can access the Audit Trail Report? .................................................................................... 9:49
   How do I set up the Audit Trail feature in ICMS? ..................................................................... 9:50
   How do I view the Audit Trail Report? ...................................................................................... 9:50
   What information is included in the Audit Trail Report? ............................................................ 9:51
   Can I print the Audit Trail Report? ............................................................................................ 9:52
   What is the Purge function? ....................................................................................................... 9:52
   Why would I want to purge the Audit Trail? .............................................................................. 9:52
   How do I purge the Audit Trail? ............................................................................................... 9:52

J. Configuring ICMS to Use Windows Account Authentication ....................................................... 9:53
   What are the options for configuring ICMS to use Windows account authentication? ............. 9:53
   Do I have to create user accounts in ICMS if I configure it to use Windows account authentication? ........................................................................................................... 9:54
   How do I set up Windows Authentication in ICMS? .................................................................. 9:54
   How do I set up the ICMS user accounts so that they use Windows authentication? ............... 9:55
   How will users login once the system is configured to use Windows Authentication? ................. 9:56

VII. SYSTEM OPTIONS

A. Overview ......................................................................................................................................... 9:57
   What is System Options? ............................................................................................................. 9:57
   Do I need special security rights to use System Options? .......................................................... 9:57
   When would I use System Options? .......................................................................................... 9:57
B. System Level Options

- What are the system options on the Data Management tab?
- What is Paging?
- What are the paging options I can set?
- What is the Auto Save time interval?
- How do I set the Auto Save time interval?
- What is the Allow Sweep word index to use Bulk Load?
- What is the Index words contained in recognized attached documents option?
- What types of attached documents can be searched in ICMS?
- What system information is on the Imaging tab?
- What options are on the Generic Table Configuration tab?
- What options are on the Audit Trail tab?

C. Client/Workstation Options

- What options are available on the Client/Workstation Options tab?

D. Directory Options

- What options are available on the Directory Options tab?
- What is Table Sharing?
- What is the Set Public Search Fields function?
- How do I set up the Public Search fields for a directory?

E. Table Sharing for Cultural Resources Directories

- How do I establish table sharing for my Cultural Resources directory?
- How do I set duplicate catalog number checking for Cultural Resources?
- How do I connect the Archives directory to my Cultural Resources directory?

F. Table Sharing for Natural History Directories

- How do I establish table sharing for my Natural History directory?
- How do I set duplicate catalog number checking for Natural History?
- What other tables should I share in the Natural History directory?

G. Table Sharing for Archives Module Directories

- How do I establish table sharing for my 4-level Archives directory?
- How do I connect my 4-level Archives directory to my Cultural Resources directory?
- How do I establish table sharing for my Item Level Archives directory?

H. Other Table Sharing Options

- What if my unit manages multiple collections?
- Can I share user-built authority tables between directories?
- How do I set up table sharing for authority tables?
- What other tables can I share between directories?

VIII. AUTOSAVE

A. Overview

- What is Autosave?
- How often is my data saved in autosave?
- How does Autosave work?
- What kind of records are saved with autosave?

B. Autosave Notification

- What is the Autosave Notification?
- What should I do if I get this autosave notification?
- What does the View Now option do?
- What does the View Later option do?
IX. LARGE DATA SETS AND PAGING

A. Overview ................................................................. 9:76

What are Large Data Sets? ........................................ 9:76
What is Paging? ......................................................... 9:76
How do I know if I need to use Paging? ...................... 9:76
How will Paging affect the use of records in a directory? 9:76
Can I set how many records are downloaded per page? 9:76
What features are affected by Paging? ......................... 9:77

B. Large Data Set and Paging Settings .......................... 9:77

How do I change the Large Data Set and Paging settings? 9:77
How do I set the maximum number of records before Paging is activated? 9:77
What is the “Default number of records per page when Paging” setting? 9:78
What is the setting for records to return when using Filter or Advanced Search? 9:78

C. Large Data Set Navigation ...................................... 9:79

How do I navigate through the pages when Paging is activated? 9:79
Do I have to use the Large Data Navigator when Paging is activated? 9:79
When would I not want to use the Large Data Navigator? 9:79
How do I turn on the Large Data Navigator? .......................... 9:79
What does the Total Records number indicate in the Large Data Navigator? 9:79
How do I move through the pages of records when Paging is activated? 9:80
How do I jump to a specific record when Paging is activated? 9:80
How do I return to the very beginning of my records? .......... 9:80
Why do the First Record and Last Record functions not go to the very beginning or end of my data? ......................... 9:80
Can I use Quick Sort when Paging is activated? .............. 9:80
How is My List View affected by Paging? ........................ 9:81
Can I use Grouping when Paging is activated? ................. 9:81

D. Filtering Large Data Sets ......................................... 9:82

Can I use Quick Filter when Paging is activated? .......... 9:82
How do I use Advanced Filter with Large Data Sets and Paging? 9:82
What is the Limit Records Returned To setting? ................ 9:82
Can I change the default setting from the Advanced Filter window? 9:83
How do I order the results of a filter when using large sets of data? 9:83

E. Searching in Large Data Sets .................................... 9:84

Can I use Quick Search with Large Data Sets? ................ 9:84
How are the Quick Search results affected by large data sets? 9:84
How do I use Advanced Search with Large Data Sets and Paging? 9:84
What is the Limit Records Returned To setting in Advanced Search? 9:85
Can I change the Limit Records Returned To setting? ................................................................. 9:85
Can I view all records found in an Advanced Search if the results exceed the number in the Limit Records Returned to setting? ........................................................................................................ 9:86

F. Other Functions Affected by Large Data Sets ........................................................................... 9:86

How is the Print List and Preview List affected by Large Data Sets and Paging? .................. 9:86
How are the Export List options affected by Large Data Sets and Paging? ......................... 9:86

X. SOFTWARE UPDATES & WORKSTATION SYNCHRONIZATION

A. Overview ....................................................................................................................................... 9:87

What is Software Updates? ........................................................................................................... 9:87
When would I use Software Updates? .......................................................................................... 9:87
What is Workstation Synchronization? .......................................................................................... 9:87

B. Applying Software Updates ........................................................................................................ 9:87

How do I access Software Updates? ............................................................................................. 9:87
How do I install a software update? ............................................................................................... 9:88
How do I synchronize the workstations? ....................................................................................... 9:88
What is the Activate Software link? ............................................................................................... 9:88
What is the Synchronize Workstations link? .................................................................................. 9:88
What is the Email Upgrade/Patch Log? ......................................................................................... 9:89
I. RECLASSIFY AND SWEEP WORDS

A. Overview

1. **What is the purpose of the Reclassify and Sweep Words function?**
   
The Reclassify and Sweep Words function lets you update the Word Search index for one or more data directories, if needed.

   This process updates the list of words that the system uses when you do a word search. The list includes:

   - an example of each word used in the database, and
   - a reference to every record that contains the word

   **Note:** Word Search will find only words in your data that have been indexed. Numeric and date fields may not be indexed. Many common words are not indexed, such as articles (the, a, and an) and prepositions. See Section C below for words excluded from word search.

2. **How does Reclassify and Sweep update the Word Search list?**
   
The Reclassify and Sweep process updates the word search list by:

   - adding any new words from new or updated records
   - removing any words that have been deleted from records
   - placing pointers to new word locations
   - removing pointers to records for words that have been deleted

   **Note:** Reclassify and Sweep rebuilds the Word Search index for all records in the selected directory. For large amounts of data, it may take some time for the process to finish, depending on the size of your database and the speed of your computer. You may work in other areas of the program while Sweep is running.

3. **Do I need special security rights to run Reclassify and Sweep?**
   
   Yes. You must have Administrator security rights to use the Reclassify and Sweep function. See Section V of this chapter for information on user security.

B. Running Reclassify and Sweep Words

1. **When do I need to run the Reclassify and Sweep function?**
   
The software automatically maintains the Word Search index for all records. As you add or modify records, the program automatically updates the Word Search index so that searches will be accurate.

   After you Add, Modify, or Copy a record and save it, the data you entered is immediately searchable through Quick Search and Advanced Search. Likewise, changes you make using the following functions are also automatically reclassified and immediately available to searches:

   - Spell Check
   - Mass Supplemental Update
   - Modify All Records
   - Global Search & Replace
• Quick Entry
• Import
• Data Updates (formerly Laptop Copy)
• Load to Empty Directory
• Transfer to Another Directory

**Note:** The following types of attached multimedia files are word searchable: PDF, Word Docs (.doc and .docx), Excel files (.xls and .xlsx), and Text files (.txt). This means that when they are being attached, the program “scans” them to add the words they contain to the word search index automatically.

If a search does not find data that you know is in your database, use Reclassify and Sweep Words to update the Word Search index for the specific directory.

2. **How do I run Reclassify and Sweep Words?**

To run Reclassify and Sweep Words:

• From the Tools menu, choose Reclassify and Sweep Words.

• In the List Pane, select the directory you want to sweep. In systems with many data directories, you can select multiple directories by pressing Shift-Up/Down Arrow, Shift-Click or Ctrl-Click. You can select all directories by pressing Ctrl-A.

• Click Reclassify # Selected Directory to start the process on the Reclassified Words Information page. When complete, a message will indicate the process is finished.
3. **Can I reclassify and sweep a specific group of records?**

Reclassifying a tag set is not yet available in **ICMS**. When it becomes available in a future update, you will be able to activate a tag set and click Reclassify Tag Set on the Tag Set toolbar.

**C. Word Search List**

1. **Can I see a list of the words in my Word Search list?**

Yes. You can view the list of words that Word Search uses when you access the Advanced Search function.

To access Advanced Search:

- On the button bar, click the Advanced Search button
- From the Record menu, select Advanced Search,
- Press Alt-8 on your keyboard.

Then in the Advanced Search window:

- Press F5 or select Concordance List on the Tools menu.

All the words available for Word Search are on this list. If the word you are searching for is not on the list, Word Search cannot find records that match. Run the Reclassify and Sweep Words function if you cannot find words in the list that you are sure are in the database.

2. **Is every word that I enter kept in my Word Search list?**

No. Reclassify excludes a number of common words (“a”, “an”, “the”, etc.) and prepositions from the Word Search list.
3. **How can I view the excluded words list?**

You can access the excluded words list from several places:

- Tools menu from any module (select Words to Exclude from Word Search)
- Advanced Search window (select Excluded Words from the Tools menu)
- Reclassify and Sweep Words window

To view the words excluded from Reclassify and Sweep, click **Edit Words to Exclude from Word Search**.

4. **How do I add or delete words in the excluded words list?**

   - To add a word to exclude, click **New Word**. A new box will open at the end of the list. Enter the new term and press enter.
   
   - To delete an excluded word so that it will be searchable, highlight the word in the list and click **Delete Selected Word(s)**.
   
   - You can also modify words in the list. Highlight the word and click **Edit Word**.

**Note:** After you have added, modified or deleted words in the Excluded Words list, you must Reclassify and Sweep the directory for Word Search to record the changes. Refer to Section B above.

5. **Can I print the excluded word list?**

   Yes. Click **Print List** at the top left of the Excluded Words list window. Then click the printer button in the preview window.

D. **Analyze Sweep Tables**

1. **What is the Analyze Sweep Tables tool?**

   ICMS recognizes most commonly used symbols and characters. More unusual ones may cause the word search indexes to become blank which results in word search not finding results for any searches. When this happens, the Analyze Sweep Tables tool can be used to analyze the word search indexes.
These unusual symbols or characters may be introduced into the data when a user copies text in a Microsoft Word document and pastes it into ICMS. Microsoft Word uses hidden formatting codes and has an autocorrect feature that will often turn one symbol or character into a variation of it. For example, when you type a single or double quotation mark (‘ or ”) in Word, it will turn it into a variation of a quotation mark called a curly (smart or typographer's) quote (‘’ or “”) as you type. [Note: you can turn this feature off in Word by going to AutoCorrect Option on the Tool menu in Word 2003. See Help for different versions of Word.]

2. How do I know if I need to use the Analyze Sweep Tables tool?

If no word searches work in a particular location in the program (in Catalog records for example) even after running the Reclassify and Sweep Words tool (section B above), press F5 while on the Advanced Search screen to bring up the concordance list. If this list is empty, you can use this tool to potentially find problematic symbols or characters in your data.

Note: It is recommended that you consult with the technical support staff at Re:discovery Software before using this tool.

3. How do I run the Analyze Sweep Tables tool?

To run the Analyze Sweep Tables tool:

- On the Tools menu, select Analyze Sweep Tables

![Analyze Sweep Tables window](image)

- Click the “Verify sweep tables” button.

- It will check tables in all of the directories in ICMS to see if any of the sweep tables are empty. If it finds any, it will return a message letting you know which ones.

- Click OK on the message.

- Click the “Copy messages to the clipboard” button.
• Open a document or email and press Ctrl-V to paste the messages. You can refer to these later or potentially send to a member of the tech support team at Re:discovery Software.

• Click OK.

• If the tool found empty sweep tables in your directories, click the “Find Special Characters in Identified Tables” button. This checks the related tables for problem characters or symbols. If it finds any, it will return a message with details letting you know the character found and which table, record, and field it is located in.

• Click OK on the message.

• If it found any special characters, click the “Copy Messages to Clipboard” button again and then paste the message with the details in a document or e-mail message to refer to later to send to a member of the tech support team at Re:discovery Software. Click OK.

• Click Close to close the Analyze Sweep Tables tool.

At this stage, you have the information you need to know which records need editing in order to remove the problematic characters.

Once you have edited the records returned by the Analyze Sweep Tables tool, you will need to run Reclassify and Sweep for the affected directories so it can properly rebuild the word search indexes.

This tool will not catch every conceivable problematic character or symbol but we continue to update the program as others are encountered. If the tool does not report any problems or if you are still having problems after following all of the above steps, please contact the tech support team at Re:discovery Software Inc.
II. BACKUP DATA

A. Overview

1. Does ICMS include a backup utility?
Yes. ICMS includes a Backup Data utility. However, if your unit already has a reliable backup system, it is recommended that you continue to use it. You must use the Backup Data utility in ICMS:

- if you do not have a reliable backup system in place
- to perform data backups from within ICMS
- to provide a backup of your data for your annual submission to WASO and the National Catalog (for NPS only)
- to provide data to the NPS Web Catalog (if subscribed) (for NPS only)
- to send data to another unit or contractor
- to move your system to a new computer

**IMPORTANT:** If you are using another backup system, make sure that the backup software is “database aware”. Since ICMS uses SQL databases, these files are always in use by SQL and thus cannot be copied, deleted or moved (a security feature of SQL). Thus, file-based backup systems are not able to make copies of the database files. Many backup systems have additional features that can be added or turned on to make them database aware. Consult your backup software’s documentation.

2. How does the Backup Data utility work?
The backup options in ICMS use XML files to create backups of the SQL data (rather than SQL .bak files) and SharpZip (or Zip64) library utility to create compressed copies of select data and system files. Use these compressed copies as your backups. The Backup Data utility has 5 options for users to make data backup copies.

3. Do I need special security rights to use the Backup Data utility?
Yes. The Backup Data utility is security-protected. You must have Administrator security rights to access this utility. Refer to Section VI of this chapter for information on security.

4. Why should I back up my ICMS data?
Make regular backups of your ICMS data to save your information from loss. For NPS, you also need to make a copy of your data for your annual submissions (catalog records, CMR and ACP) to WASO and the National Catalog.

ICMS gives you the increased convenience of performing and tracking your collection documentation and management processes in one central location. Having all your object data and collection management data together also increases the importance of keeping that data safe. You have an obligation to keep the government’s records secure. Spend the time it takes to make and store electronic copies of your data.

Your computer and its data are vulnerable in the event of:

- catastrophic natural occurrences such as floods, earthquakes, fires
• power outages or fluctuations
• employee error
• employee sabotage
• theft

5. **How often should I back up my ICMS data?**
   If your unit does not have a reliable backup system already, make backup copies of your data after long sessions of data entry and editing. You should also back up your data before making major changes like Modify All and Global Search and Replace in case a mistake is made during that process.

6. **Where should I store my ICMS data backup media?**
   Store your data in a safe place away from your work area, preferably in another building in a locked, fireproof safe. Make sure that both your computer and its backup data are not vulnerable to the same events at the same time.

7. **How should I back up my ICMS data?**
   **For WASO and National Catalog Submissions (NPS only):**
   Use the Backup Data utility in ICMS to create the compressed file that will be uploaded to the catalog submission ftp site through the internet. You may also wish to write the backup to a CD or other large storage capacity media.

   **For your protective data backups:**
   Use the most convenient and efficient backup procedures available.

   **If your unit…**
   **Then**
   
   has reliable equipment and procedures in place to regularly backup ICMS,
   continue to use those.

   does not have reliable equipment and procedures in place to regularly backup ICMS,
   use the Backup Data utility in ICMS and a CD writer or other large capacity storage media.

8. **Why must I use the ICMS Backup Data utility to submit my museum records to WASO and the National Catalog (NPS only)?**
   The compressed file format created by ICMS allows the data to be loaded back into another ICMS system (the National Catalog) using a data loading function within the program. This data loading function will only accept backup files created by ICMS.

---

**B. Using the Data Backup**

1. **How do I access the Backup Data utility?**
   To access the Backup Data utility,
   
   • click on the File menu on the Menu Bar and select Backup Data, or
   
   • press Alt-F and then B on the keyboard.
You will see the Data Backup window:

![Backup Data Window]

### 2. What are the available backup options?

The available backup options are:

<table>
<thead>
<tr>
<th>Backup Name</th>
<th>Zip File Name Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete System Backup</td>
<td>CompleteSystem-{date}.zip</td>
</tr>
<tr>
<td>All databases (data only)</td>
<td>AllData-{date}.zip</td>
</tr>
<tr>
<td>National Catalog Submission</td>
<td>ACP-directory-CatalogSubmission-{date}.zip</td>
</tr>
<tr>
<td>Web Catalog transfer</td>
<td>directory-WebCatalogTransfer-WithImages-{date}.zip</td>
</tr>
<tr>
<td>Selected Directories</td>
<td>directory-{date}.zip</td>
</tr>
</tbody>
</table>

**Note:** All zip file names include the date in the name. The options that allow you to select directories will also include the directory names chosen in the filename (e.g., CR_PARK-NH_PARK-8-21-2009.zip)

**Include Images and Media**

This option, when checked along with one of the main backup options, will include all images and multimedia associated with the selected directory. This option is automatically included with a Complete System backup and the Web Catalog transfer. You may wish to select it for the All databases or...
Selected directories backups. It is not available with the National Catalog Submission backup.

Note: The backup file name will reflect this option by including “WithImages” in the file name.

Include files shared with other directories

This option, when checked along with one of the main backup options, will also select other directories that have shared data with the directories you have chosen to backup. This shared data might include:

- accession information
- artist/maker data
- names and addresses
- authority table data

For example, your main Natural History directory shares the accessions information with the Cultural Resources directory. If you are only backing up the Natural History directory, you would not get the accessions information unless you selected this option to include the shared data. This option is automatically included in the Complete System backup and the All databases backup. You may select it for the Selected Directories backups if desired. It is not available with the National Catalog Submission or Web Catalog transfer option.

3. What are the steps to run a backup?

The basic steps for running a backup are:

- Select a backup option.
- Select directories if the backup option requires it.
- Select whether to Include Images and Media and/or Include files shared with other directories, if available.
- Select the location to save the backup file.
- Optionally select to name the backup file manually.
- Click Start Backup.

4. Are there options to restore my data from a backup?

Yes. Use the Load to Empty Directory utility located on the File menu. See Section VI of Chapter 8 for further information on Load to Empty Directory.

If you have a Complete System backup, you can also use the Restore Full System Backup option on the File menu. This option is very useful when moving the program to a new computer. See Section III in this chapter.

5. How will I be able to distinguish between my backups if they have the same name?

Notice that in each zip file name the date is included in the file name. This provides an instant reference to the date the backup was made and usually a unique file name (unless the backup was made on the same date as another).

C. Complete System Backup

1. What is the Complete System Backup option?

This option includes the entire program, data and images. This option automatically includes images and all shared data. It can be used to restore your system if your computer fails or you wish to move the program to a new computer (see Section III: Restore Full System Backup).
Note: This is the recommended backup option if you are not using a commercial product specifically designed to backup computer files to protect your entire computer system.

For bureau units such as centers and regional offices that have extremely large ICMS systems with many directories and thousands of images and media, you should not use the Complete System Backup option as it will take a long time to run and the resulting zip file may be too large to move easily. You can use the Selected Directories backup options to select smaller groups of directories at a time to backup. Be sure to check the box to Include Images and Media when you use this option.

2. How do I run the Complete System backup option?

To run the Complete System backup:

- In the Backup Data window, select the Complete System backup option.

- Select the location to save the backup file by typing a path in the location field or clicking Browse to select a location.

- You also have the option to name the zip file with a different name. To do this, uncheck the “Use default backup zip filename”. Another field will appear below the Default backup zip filename allowing you to enter an alternate name. Note: It is recommended that you use the default backup zip filename so that it is easier to identify the type of backup file that is created.

- Click Start Backup.

- You will receive a warning message that this may take a long time without the option to cancel. Click Yes to proceed with the backup.

- Once the backup has completed, you will receive a confirmation message with the name and location of the zip file. Click OK.

The resulting zip file will be named:

**CompleteSystem-date.zip**

D. All Databases (data only)

1. What is the All Databases backup option?

This option includes all databases for all directories. You have the option to include images with this backup by checking Include Images. It creates a backup of the data only for all directories.

2. How do I run the All Databases backup option?

To run the All Databases backup option:

- In the Backup Data window, select the All Databases (data only) backup option.

- Select the location to save the backup file by typing a path in the location field or clicking Browse to select a location.

- If you want to include images with your data, check the Include Images option.

- You also have the option to name the zip file with a different name. To do this, uncheck the “Use default backup zip filename”. Another field
will appear below the Default backup zip filename allowing you to enter an alternate name. **Note:** It is recommended that you use the default backup zip filename so that it is easier to identify the type of backup file that is created.

- Click **Start Backup**.

- You will receive a warning message that this may take a long time without the option to cancel. Click Yes to proceed with the backup.

- Once the backup has completed, you will receive a confirmation message with the name and location of the zip file. Click OK.

The resulting zip file will be named:

- **AllData-date.zip**
- **AllData-WithImages-date.zip** (if you included images and media)

## E. National Catalog Submission (NPS Only)

1. **What is the National Catalog Submission backup option?**

   This option includes selected directories and your Automated Checklist (ACP) data for your park to submit to the NPS National Catalog. Images are not included with this backup. Your submitted data is used to print catalog cards, generate Collections Management Report (CMR) records, and aggregate service-wide ACP data.

2. **When do I submit my records to the National Catalog?**

   Submit your records by the national deadline, currently September 15.

   **Complete your ACP update before creating the backup for the National Catalog Submission. Refer to Appendix J for information on completing your ACP.**

3. **How do I prepare my data for submission to the National Catalog?**

   To prepare data for submission to the National Catalog:

   - Check accession records to ensure all new accessions have an Acquisition Date in the proper format, such as “01/31/2011”

   - From the Tools menu, run the Fiscal Year Summary Report. If the report lists duplicate catalog numbers, draft records, invalid accession numbers, or other problems, correct those issues in your data.

   - Create tag sets of the new and re-catalog records you are submitting for printing.

   Use the Search, Filter and Tag Set functions to create tag sets of the Cultural Resources and Natural History catalog records to submit for printing. Make one tag of new and re-cataloged records in the Cultural Resources directory, and one tag of new and re-cataloged records in the Natural History directory. Name tag sets using the park acronym, Cultural Resources (CR), or Natural History (NH) designator, and two-digit fiscal year.

   Example: **GETTCR09**
   **GETTNH09**
4. **What records should not be included in my tag sets?**

Records with DRAFT RECORD in the Object Status field should not be included in your tag sets. The National Catalog does not count or print records with the object status DRAFT RECORD. Use the Sort or Filter functions to identify draft records in your tag sets. Complete these records or remove them from your tag sets before making your backup for National Catalog Submission.

5. **What records do I include in my tag sets?**

The tags should include new catalog records the National Catalog must print, and re-cataloged records you want the National Catalog to re-print. Include the catalog records that you completed or changed (other than minor modifications) during the previous fiscal year (October 1 – September 30).

The National Catalog will print archival copies of your Cultural Resources and Natural History catalog records for storage at the National Catalog. At your request, the National Catalog will print blue working copies of the records for the park.

6. **How do I back up my directories for the National Catalog Submission?**

To back up the directories:

- From the File menu, choose Backup Data.

- In the Backup Data window, select the National Catalog Submission option.

- The Management Reports module (for the ACP) will be selected automatically. Select your Cultural Resources, Natural History, and Archives directories with your park acronym. Select all that apply for your submission, even if you manage more than one park collection. Do not select “temporary” or working directories that do not have your park acronym, or that include data you are not submitting.

- Select the location to save the backup file by clicking **Browse** to select a location, such as your My Documents folder.

- “Use default backup zip filename” should be selected. Note the name of the backup file.

- Click **Start Backup**.

- You will receive a message that this may take a long time without the option to cancel. Click Yes to proceed with the backup.

- When the backup is complete you will receive a confirmation message with the name and location of the zip file. Click **OK**.

You will find the backup zip file in the location you selected, such as your My Documents folder. The backup zip file will be named:


Where “PARK” is your park acronym, and the date is the date you made the backup. **DO NOT re-name your backup zip file.**

*Always include your Cultural Resources, Natural History, and Archives directories in the backup, even if there are no new records for the year. This ensures that the National Catalog receives all related records.*
7. **How do I submit the backup?**

To submit your records:

- Use Windows Explorer or My Computer to locate your backup zip file. Single-click to select the zip file. Copy the file using Ctrl-C on the keyboard; or right-click and choose Copy; or choose Copy from the Edit menu. **Note:** You will not see anything happen. The file is copied to the Windows “clipboard” waiting to be pasted.

- In the Address line near the top of Windows Explorer or My Computer, type this address:

  ftp://67.221.117.85/catalogsubmissions/

  and press Enter or click the “Go” button. When prompted:

  Enter the user name: NCSNPS
  Enter the password: ICMSncs1!

  **Note:** You may see other park zip files at this site.

- Paste your file using Ctrl-V on the keyboard; or right-click and choose Paste; or choose Paste from the Edit menu. You’ll see your file copying onto the ftp site. Copying may take several minutes. When it is done, you will see your file on the site. Then close your Internet browser.

**Note:** if you open Internet Explorer and go to the FTP site, you will not be able to paste your file. From the View menu in Internet Explorer, or from “Page” next to the Home and Print icons, choose “Open FTP site in Windows Explorer.” Then login and paste your file.

**Note:** if you have difficulty copying your file to the FTP site, you may receive a message such as “access denied” and “check permissions.” Ask your network administrator or IT staff to try to upload the file. Some offices place limits on which users are allowed to upload files, or have limits on the size of files that may be uploaded. Someone with administrative rights on your network should be able to upload the file for you.

8. **What else should I do to complete the submission?**

Send an e-mail to the group “WASO CMR-NC Submission” or to the address CMR_Submission@nps.gov, with the following information:

- park name and acronym
- name of tag sets of catalog records submitted for printing
- list of catalog numbers in the tags (or first and last number)
- request to have blue paper catalog cards printed (optional), and any additional printing requests
- contact name, phone number, and shipping address for blue cards
- total number of research requests from within the park, and from outside the park, during the fiscal year, for inclusion in the CMR
- any noteworthy accession, deaccession or other noteworthy collections activities during the fiscal year, for inclusion in the CMR
• any adjustments needed for your CMR catalog backlog numbers, with justification.

Do not attach your backup zip file to the e-mail. Backup zip files are usually too large to send via e-mail. If you don’t have adequate access to the internet, please call the National Catalog office at 304-535-6128.

<table>
<thead>
<tr>
<th>F. Web Catalog transfer (NPS Only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is the Web Catalog transfer backup option?</td>
</tr>
<tr>
<td>Use this option to backup collection directories to send to the NPS Web Catalog with the selected ICMS data, images, and multimedia you wish to submit to the web catalog. It will automatically include any catalog and exhibit records with their attached images and multimedia files that are marked as Web Ready.</td>
</tr>
<tr>
<td>2. What data is included in the Web Catalog transfer backup option?</td>
</tr>
<tr>
<td>Only catalog records and exhibit records that are marked as Web Ready will be included in the Web Catalog transfer backup. In addition, any images and multimedia files attached to those records that are also marked Web Ready will be included. It is important to do a basic check of your data before submitting it to the NPS Web Catalog. Certain records (such as deaccessioned and draft records) should not be included in your submission. See Appendix X: Web Catalog for further information on how to prepare your data for the web catalog. Note: The directory containing the Web Catalog records must have all records that you want to appear on the Web Catalog. New records cannot be appended to existing records already appearing on the Web Catalog site.</td>
</tr>
<tr>
<td>3. How do I run the Web Catalog transfer backup option?</td>
</tr>
<tr>
<td>To run the Web Catalog transfer option:</td>
</tr>
<tr>
<td>• In the Backup Data window, select the Web Catalog transfer backup option.</td>
</tr>
<tr>
<td>• Select the directory you wish to backup. Note: You can only backup one directory at a time with this option. The Web Catalog will only accept a single Cultural Resources directory and a single Natural History directory.</td>
</tr>
<tr>
<td>• Select the location to save the backup file by typing a path in the location field or clicking Browse to select a location.</td>
</tr>
<tr>
<td>• You have the option to name the zip file with a different name. To do this, uncheck the “Use default backup zip filename”. Another field will appear below the Default backup zip filename allowing you to enter an alternate name. Note: It is recommended that you use the default backup zip filename so that it is easier to identify the type of backup file that is created.</td>
</tr>
<tr>
<td>• Click Start Backup.</td>
</tr>
</tbody>
</table>
• You will receive a warning message that this may take a long time without the option to cancel. Click Yes to proceed with the backup.

• Once the backup has completed, you will receive a confirmation message with the name and location of the zip file. Click OK.

• If you are submitting two directories (CR and NH), repeat these steps and select the second directory to back up.

The resulting zip file will be named:

CR_Directory-WebCatalogTransfer-WithImages-\{date\}.zip
or
NH_Directory-WebCatalogTransfer-WithImages-\{date\}.zip

4. **How do I submit my Web Catalog data?**

There are two ways to submit your Web Catalog records after running the Web Catalog transfer:

• Upload the file(s) to the Re:discovery ftp site, or
• Send a CD with the Web Catalog transfer zip file(s) on it

To upload the file(s) to the Rediscovery ftp site:

• Use Windows Explorer or My Computer to locate your web catalog transfer zip file(s) created in step 3 above. Highlight the zip file(s). Copy the file(s) using Ctrl-C on the keyboard; or right-click and choose Copy; or choose Copy from the Edit menu. **Note:** You will not see anything happen. The files are copied to the Windows clipboard waiting to be pasted.

• Open your Internet browser (such as Internet Explorer). Type the following address:


• Paste your files using Ctrl-V on the keyboard; or right-click and choose Paste; or choose Paste from the Edit menu. You’ll see your files copying onto the ftp site. Copying may take several minutes. When it is done, you will see your files on the site. Then close your Internet browser.

To send a CD:

• Write the Web catalog transfer zip file(s) to a CD or DVD using your computer’s CD/DVD writing software.

• Mail the disk to:
  Re:discovery Software, Inc.
  ATTN: NPS Web Catalog
  3040 Berkmar Drive, Suite B1
  Charlottesville, VA 22901

**Note:** With either FTP or mail, send an e-mail to support@rediscov.com to inform Re:discovery that you have sent a Web Catalog submission.
5. **How often can I submit records to the Web Catalog?**

   You may submit your records anytime you have a new exhibit you want to post or newly added or edited records you want to be available on the Web Catalog. It is probably best to submit when you have groups of records ready to go. Remember that you must submit your entire selection of Web Ready records each time – new records cannot be appended to existing records already appearing on the Web Catalog site.

6. **Where can I view the Web Catalog data for my park and other parks?**

   To view the catalog data posted on the NPS Web Catalog site, in Internet Explorer enter the following address:

   http://www.museum.nps.gov

   The parks that have data posted are listed alphabetically.

---

G. **Selected Directories**

1. **What is the Selected Directories backup option?**

   This option includes all data with supplemental and associated module data from any directories selected. You can select multiple directories to back up at the same time. They will be contained in the same zip file.

   **Note:** This option is highly recommended before you perform any mass modification functions such as Modify All and Global Search & Replace just in case you need to revert back to the original data.

2. **How do I run the Selected Directories backup option?**

   To run the Selected Directories backup option:

   - In the Backup Data window, select the Selected Directories backup option.
   
   - Check the directory you wish to back up. You can check as many directories as desired. They will all be contained in the same zip file.
   
   - You can choose Include Images and Media if you want to back up the images with the selected directories.
   
   - You can choose to Include files shared with other directories. **Note:** This will include other directories in the backup that contain the shared files.
   
   - Select the location to save the backup file by typing a path in the location field or clicking **Browse** to select a location.
   
   - You have the option to name the zip file with a different name. To do this, uncheck the “Use default backup zip filename”. Another field will appear below the Default backup zip filename allowing you to enter an alternate name. **Note:** It is recommended that you use the default backup zip filename so that it is easier to identify the type of backup file that is created.
   
   - Click **Start Backup**.
   
   - You will receive a warning message that this may take a long time without the option to cancel. Click Yes to proceed with the backup.
Once the backup has completed, you will receive a confirmation message with the name and location of the zip file. Click OK.

The resulting zip file will be named:
- `Directory-date.zip`
or
- `Directory-WithImages-date.zip` (if you included images and media)

(`Directory` will be the names of the directories you selected – e.g., CR_PARK-NH_PARK.)

**H. Advanced Database Backup and Restore**

1. **What is the Advanced Database Backup and Restore option?**
   
The Advanced Database Backup and Restore is an advanced tool to backup, rename or restore databases. For most cases, the routine directory backups in **ICMS** are adequate so this advanced feature should only be used at the direction of a Re:discovery Technical Support team member. No program components are backed up with this process.

   *Do not use these backup options unless you are experienced with Microsoft SQL Server and only at the direction of Re:discovery’s Technical Support team.*

2. **How do I access the Advanced Database Backup and Restore options?**
   
   To access the Advanced Database Backup and Restore options, click on the **Advanced Database Backup and Restore** link at the bottom of the Backup Data window.

3. **What options are available in Advanced Database Backup and Restore?**
   
The following options are available in the Advanced Database Backup and Restore window.

   **Note:** For all options, you must know your SQL instance name, SQL login and password.

   - **Backup**
     
     This option creates a SQL backup of selected databases within the program.

   - **Rename**
     
     This option allows you to rename the SQL databases.

     **Warning:** renaming databases connected to **ICMS** will make them inaccessible to the program.
Restore

This option will restore a backup of a SQL database.

Warning: If you enter the same name as an existing database, this will overwrite the existing database with the backup.

I. System Administration Module

1. What is the System Administration Module?

   The System Administration Module gives access to creating and scheduling SQL backups and viewing ICMS system options. Contact Re:discovery Software Inc. before using either of these features for assistance.

2. How do I access the System Administration Module?

   To access the System Administration Module, click on the Start System Administration Module link at the bottom of the Backup Data window.

   Note: This module can be opened outside of the ICMS program by going to the local C:\Program Files (x86)\Rediscovery Software Inc\Rediscovery Proficio Workstation\Bin folder and double-clicking the SystemAdministrationModule.exe application file.
3. **What options are available in the System Administration Module?**

   The System Administration Module allows you to:

   - Designate the Database Backup model: Full or Simple
   - Make an immediate backup of your SQL databases
   - Indicate an email for notifications of scheduled SQL backups
   - Indicate the network account and password under which the backups will run
   - Set a schedule for when backups will occur: Daily, Weekly, Monthly and Yearly schedules can be created
   - Indicate the location to save the backups and how many to retain
   - Restore databases to a selected point in time with assistance from Re:discovery Software Inc. technical support
   - Run SQL scripts on selected databases with assistance from Re:discovery Software Inc. technical support
   - View and Update System Options with assistance from Re:discovery Software Inc. technical support. **(WARNING: Do not attempt to make any changes to System Options without explicit instruction from a Re:discovery Technical Support team member! Incorrect changes may make your program inoperable.)**

4. **What is the System Options View/Update tab used for?**

   You may use this screen with assistance from Re:discovery Software Inc. technical support, to update the program’s system options table, if needed.
III. RESTORE FULL SYSTEM BACKUP

A. Overview

1. What is the Restore Full System Backup utility?
   
   Restore Full System Backup allows you to restore your system back to a point in time when a complete system backup was created.

2. Why would I need to restore a full system backup?
   
   You may need to restore a full system backup for several reasons:
   
   • your system crashed and all data was not recovered
   
   • you are moving your data to a new machine
   
   • you want a copy of the entire system on a standalone laptop

   Note: Your ability to recover the most current copy of your data from a complete loss using this feature is dependent upon the frequency with which you perform the Complete System Backup from the Backup Data options (see Section II above).

3. How does the Restore Full System Backup utility work?
   
   The Restore Full System Backup utility uses a Complete System backup zip file created in the Backup Data utility (see Section II above). It recreates and loads all directories and data that were in your system at the time you ran the complete system backup including management reports, security, images and media.

   WARNING: If you restore a Complete System Backup to your current system that has data, any changes or additions to existing data that were made after the date of the complete system backup zip file will be lost. In addition, any new directories that may have been created after the complete backup was made will be inaccessible.

4. Do I need special security rights to use the Restore Full System Backup utility?
   
   Yes. The Restore Full System Backup utility is security-protected. You must have Administrator security rights to access this utility. Refer to Section VII of this chapter for information on security.

B. Using the Restore Full System Backup

1. How do I access the Restore Full System Backup utility?
   
   To access the Restore Full System Backup utility, click on the File menu on the Menu Bar and select Restore Full System Backup.
2. How do I use the Restore Full System Backup?

To use the Restore Full System Backup, start the program by right clicking the shortcut and selecting Run as Administrator to avoid any permissions issues. Then login to the program as an administrator. You will need the CompleteSystem-(date).zip file accessible on the computer where you have ICMS installed.

To restore your ICMS from a complete system backup zip file:

- From the File menu, choose Restore Full System Backup.

- In the Restore Full System Backup window, click the Browse link to navigate to and select your CompleteSystem-(date).zip file.

- Leave the Keep Current Installation Location checked so that installation configuration settings are not replaced in the current installation with old ones from the backup.

- Click Restore System.

- A message will open indicating that the process may take a long time and cannot be canceled. Click Yes to continue.

- Wait while the system unzips and restores the data. Please be patient -- this may take a long time.

- When the restore process is complete, click OK.
3. **How do I move ICMS to a new computer?**

To move ICMS to another computer, follow these steps:

**Note:** Both the old installation and the new installation of ICMS must be in the same version to move the data. You may need to upgrade your old installation prior to creating a backup that will be moved to the new installation.

- Create a Complete System Backup* from the Backup Data function on your current computer (see Section II above). **Note:** If your computer failed and you do not have a complete system backup, please contact Re:discovery Software, Inc at (434) 975-3256 or support@rediscov.com for further assistance.

  *Note:* For NPS Centers, BOR Denver, or other units that manage many collections in a single copy of ICMS, the Complete System Backup option may be unable to complete because SQL has a limit on the length of the backup command. In that case, use the Selected Directory backup option (with Images), and select individual or small groups of directories to backup. Make sure to include the Management Reports (ACP) in one of your backups.

- Install ICMS on the new or repaired computer using the installation disk and instructions (see Appendix B or the documentation on the disk). **Note:** If you are installing on a server, make sure to set up the share in step 9 of the installation instructions. You will need this UNC path for this share in step 19 of those same instructions. And use the 3-Installation-Network Configuration.doc instructions from the documentation folder to establish exceptions in the firewall for SQL.

- After installing, start the program by right clicking the shortcut and choosing Run as Administrator to avoid any permission issues. Then, login to the new ICMS installation with user name = red and password = red.

- Depending on the type of backup you created, use one of the following restore methods:
  - -- Complete System backup zip file: Go to the File menu and select Restore Full System Backup to restore your backup to the new computer (see section B.2 above).
Selected Directories backup zip files: use either Load to Empty Directory on the File menu (Chapter 8, Section VI) or Software Updates on the Tools menu (Section X of this chapter) to load your data. To load the Management Reports (ACP), you must use the Load to Empty directory option.

In some cases, it may be more expedient to use SQL Management Studio to backup and restore your databases from the old system to the new. Contact Re:discovery Software for further instruction on moving the databases and associated image and media files manually.
IV. CREATE NEW DIRECTORY

A. Overview

1. **What is the Create New Directory function?**

   The Create New Directory utility creates new Cultural Resources and/or Natural History directories in the Collections Management Module. It also creates Archival/Manuscript Collections directories and optional Archives Item Level directories for the Archives Module.

   For each directory it creates, the Create New Directory function:
   
   • creates all data tables
   • creates associated modules
   • sets up all supplementals

2. **Do I need special security rights to create a new directory?**

   Yes. The Create New Directory function is security protected. You must have Administrator security access to use this utility. Refer to Section V of this chapter for information on security.

3. **When would I use the Create New Directory function?**

   Use this function any time that you need to add a directory.

4. **Why would I need to add a directory?**

   There are several reasons that you might need to add a directory. You may:
   
   • wish to create a “working directory” for catalogers to enter and store catalog records until the records have been approved. After the records have been approved, you can transfer them to your master database.
   
   • acquire a collection that you are going to manage separately. You will then need to create a new directory (either natural history or cultural resources) for this new collection.
   
   • want to use an extra directory as a “holding directory” when you are using such functions as Import/Export, Load to Empty Directory, Transfer Record(s) from Disk, and Data Updates (Laptop copy). Using a holding directory when you move groups of records will reduce the possibility of harming your master database.
   
   • take over collection management responsibility for another unit’s museum collection. You will then need to add directories for that unit’s records to your system.

B. Creating a New Directory

1. **How do I access the Create New Directory function?**

   To access the Create New Directory function:
   
   • Go to the Tools menu.
   • Select Create New Directory.
**Note:** Your login name must have the correct security rights to access the Create New Directory function. If you do not have the correct security rights, the Create New Directory option will be grayed-out.

You will see the Create New Directory screen.

![Create New Directory Screen](image)

You can also access the Create New Directory screen while performing several other functions that load or transfer data. For example, there is a Create New Directory link on the following function windows:

- Transfer Records from Disk
- Load to Empty Directory
- Load Data from Update Zip file (on the Data Updates menu)

2. **How do I create a new NPS directory?**

Follow these steps to create a new NPS directory:

- Enter the name of the directory. This is the name that will appear in the Navigation Pane.

  *Park Collections*
  Enter the four-letter park acronym in the form of “AAAA.” If the park collection has a modifier, enter a collection designation in the form of a letter, for example, A, B, C. Do not enter a space or symbol between the park acronym and the modifier.

  *Holding or Working Directories*
  Enter 3 to 5 characters. Do not enter any spaces or symbols. Use a combination of characters that will be meaningful to you. You may want to use the cataloger’s name or even the words “HOLD” or “TEMP.”

*Do not enter the type of collection (CR or NH) in the name. The program will supply that automatically once the directory is created.*
• Highlight the type of directory you wish to create. Directory types appear in the Directory Type box.

• Click Create Directory after selecting your options.

• You will be asked if you are sure you want to create the directory. Click Yes to proceed with the directory creation.

• A confirmation notice that the directory was created successfully appears. Click OK. The directory is now available for use.

3. **What is the Use BOR, DOI, or NPS Center Model Directory option?**

The Use BOR, DOI, or NPS Center Model Directory option allows you to create BOR style directories for Cultural Resources and Natural History directory types, DOI style directories for all directory types, or NPS center style directories customized for Cultural Resources, Natural History, and Archives (4-level) directory types.

To use, select the directory type, check the Use BOR, DOI, or NPS Center Model Directory and select the Model Type you wish to recreate from the box that appears on the right.

For BOR, there is a model for Cultural Resources and a model for Natural History. DOI has a model for each type. There are 4 NPS center models for Cultural Resources, one NPS center model for Natural History, and one NPS center model for Archives (4-level).

4. **How do I create a new BOR directory?**

Follow these steps to create a new BOR directory:

• First, check the option to Use BOR, DOI, or NPS Center Model Directory. **Note:** By choosing this option first, the Directory name field will allow you to enter more than 5 characters for the name – up to 20 characters).
5. **How do I create a new DOI directory?**

Follow these steps to create a new DOI directory:

- First, check the option to Use BOR, DOI, or NPS Center Model Directory. **Note:** By choosing this option first, the Directory name field will allow you to enter more than 5 characters for the name – up to 20 characters.
• Highlight the type of directory you wish to create. Directory types appear in the Directory Type box.

• Highlight the model for DOI in the Model Type box.

• Enter the name of the directory. This is the name that will appear in the Navigation Pane. You can enter up to 20 characters. Do not enter spaces or symbols.

Do not enter the type of collection (CR or NH) in the name. The program will supply that automatically once the directory is created.

• Click Create Directory after selecting your options.

• You will be asked if you are sure you want to create the directory. Click Yes to proceed with the directory creation.

• A confirmation notice that the directory was created successfully appears. Click OK. The directory is now available for use.
V. DELETE A DIRECTORY

A. Overview

1. **What is the Delete a Directory function?**
   The Delete a Directory function removes unneeded directories from ICMS.

2. **What kind of directories can I delete?**
   You can delete the following types of directories:
   - Cultural Resources
   - Natural History
   - Archives (4-level)
   - Archives (Item)

   *When you delete a directory, you also delete all the associated modules and supplemental records for that directory.*

3. **Do I need special security rights to delete a directory?**
   Yes. The Delete a Directory function is security protected. You must have Administrator security rights to access this function. Refer to Section V of this chapter for information on security.

4. **When would I use the Delete a Directory function?**
   Use this function if you:
   - make a mistake in naming a directory and need to delete it before you enter any data.
   - make a directory to temporarily hold records being imported or transferred into your master directory and no longer need it
   - need to remove an ICMS directory for any reason

B. Deleting a Directory

1. **How do I access the Delete a Directory function?**
   To access the Delete a Directory function:
   - Go to the Tools menu.
   - Select Delete a Directory.

   *Note: If the Delete a Directory option is grayed out, your login name does not have the correct security rights to access this function.*

   You will see the Delete Directory screen.
Delete Directory Warnings:

- **Before you delete a directory, make sure that no users are currently logged into the directory.**
- **Understand that the directory cannot be undeleted (files are not copied to the 'Trash Bin').**
- **It is highly recommended that you allow the system to create the safety backup before it is deleted.**

2. **How do I delete a directory?**

Follow these steps to delete a directory:

**Note:** To exit the Delete a Directory screen without deleting a directory, click **Cancel**.

- Select the directory that you want to delete by checking the box in front of the directory name. You can select more than one directory by checking multiple boxes or an entire module (**Be Careful!**).

- Select a backup location by either typing a path in the **Select backup location** field or clicking **Browse** to select a location to save the backup zip file. It is highly recommended that you allow the system to create a backup of the directories that you are deleting. However, if you do not want to create a backup file, check the **Do not create safety backup** option.

- Click **Delete Directory** at the bottom right.

- You will be asked if you are sure you want to delete the selected directories. Click **Yes** to proceed with the deletion.
If you chose… Then…

to create a safety backup

another warning appears that the backup process may take a long time depending on the amount of data in the directory. This process cannot be canceled once it has begun. Click Yes to proceed with the backup.

Note: You will see the backup process begin and a confirmation message that the backup was completed successfully. Click OK to continue with the deletion.

After the safety backup is created, a final warning message appears giving you one last chance to cancel the deletion. Click Yes to permanently delete the selected directories. Click No to cancel the deletion process.

If you chose… Then…

not to create a safety backup

a different message appears indicating your choice not to create the backup.

This is your last chance to cancel the directory deletion if you are not creating a safety backup. Click Yes to permanently delete the selected directories without making any backup. Click No to cancel the deletion process.
• A confirmation message appears indicating that the directory has been deleted. Click OK.

Note: The Delete Directory window will close automatically.
VI. USER SECURITY

A. Overview

1. **Does ICMS include a security system?**
   Yes. You must have a user login name (User ID) and password to use ICMS. You enter your login name and password on the Login screen to access ICMS. The system administrator can determine which users are allowed to add and edit catalog data, print reports, make mass changes to the data, delete records, use the Tools menu, and assign new users to the system. You can assign system-wide security rights or limit security rights to a particular directory.

2. **What is a User ID?**
   Your User ID identifies you as a registered user of the ICMS system. Associate your User ID with your real name.

   **Note:** User IDs become part of the museum record. Your User ID is attached to records that you enter or modify. It also appears in some supplemental records that track changes in records. Avoid using inappropriate or “cute” names.

3. **What is a password?**
   Your ICMS password protects your login name from use by others. Use it when you enter the system. Your password is linked to your User ID. Keep your ICMS password secure. Don’t share your ICMS password with others. Do not allow other people to enter the system with your User ID and password. Any changes made with your User ID are your responsibility.

4. **Where do I get a User ID and password?**
   Your ICMS system administrator or whoever installs and configures your ICMS program assigns a User ID and password to you. The same person probably assigns security rights.

5. **Can I use my Windows network login to access ICMS?**
   Yes, you can configure ICMS to use Windows account authentication for the user ID and password. See Section J below.

6. **What are user security rights?**
   User security rights determine which:
   - functions and tools you can use
   - portions of the program you can access

7. **What do I need to assign User IDs, passwords, and security rights?**
   You must have Administrator security rights to assign User IDs, passwords and security rights.
8. **How do I assign User IDs and passwords?**

   The User Security option is available on the Tools menu. Use it to assign User IDs, passwords, and security rights.

   **Note:** See Appendix B: Installation and Setup for information about a general User ID and a general password to use during installation and first-time use.

9. **Can I print a report of all User IDs in my system?**

   Yes. The User Security Profile Report will print the security rights assigned to each User ID in the system. See Section G below for more information.

10. **Can I view the user activity in my system?**

    Yes. You can view the user activity in your system by using the Manage User Log option on the Tools menu. See Section H below for more information.

11. **Can I track changes to records made by users?**

    Yes. Use the Audit Trail feature to track additions, modifications and deletions of data, as well as the user who initiated the action. See Section I below for more information about the Audit Trail Report.

---

## B. User Security

1. **How do I access the User Security**

   To access the User Security:

   - Choose User Security on the Tools menu, or

   You will see the list of users in the List Pane and the first user in the Record Pane.

   ![User Security Screen]

   **Note:** From the User Security screen, you may add a new user, delete a user, or edit a user’s security profile. If you do not have administrator rights, your own security profile will be the only one displayed and you will not be able to edit it (except to set a new password).

2. **How do I view the security information for a user?**

   To view the security information for a user, first select that user in the List Pane. That user’s profile appears in the Record Pane.
3. **What user information is available on the Main Information tab?**

The Main Information tab contains the User ID, the Full Name of the user and the User Type. It also has the link to set the password for a user.

4. **How do I go to the User Security Information tab?**

To move to the User Security Information tab for the current user:

- Click on the User Security Information tab, or
- Press Ctrl-N (next) to go to the User Security Information tab.

5. **What information is available on the User Security Information tab?**

The User Security Information tab includes the General and Specific Rights assigned to the user. You can also access the Advanced Module Permissions from this tab.

6. **What are the General Rights available and what do they allow me to do?**

General Rights are cumulative. If you have Data Entry rights, you also have access to all functions available to Research. If you have Administrator rights, you have access to all functions available to Data Entry and Research.

<table>
<thead>
<tr>
<th><strong>General Right</strong></th>
<th><strong>A user with this right can access:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator (Special Functions)</td>
<td>Automated Checklist Program</td>
</tr>
<tr>
<td></td>
<td>Automated Inventory Program</td>
</tr>
<tr>
<td></td>
<td>Collections Management Report</td>
</tr>
<tr>
<td></td>
<td>Backup Data</td>
</tr>
<tr>
<td></td>
<td>Restore Full System Backup</td>
</tr>
<tr>
<td></td>
<td>Create New Directory</td>
</tr>
<tr>
<td></td>
<td>Delete a Directory</td>
</tr>
<tr>
<td></td>
<td>Import/Export</td>
</tr>
<tr>
<td></td>
<td>Data Updates (laptop copy)</td>
</tr>
<tr>
<td></td>
<td>Load to Empty Directory</td>
</tr>
<tr>
<td></td>
<td>Transfer</td>
</tr>
<tr>
<td></td>
<td>Delete Multiple Records</td>
</tr>
<tr>
<td></td>
<td>Mass Supplemental Update</td>
</tr>
<tr>
<td></td>
<td>Mass Association Records Update</td>
</tr>
<tr>
<td></td>
<td>Modify All Records</td>
</tr>
<tr>
<td></td>
<td>Global Search &amp; Replace</td>
</tr>
<tr>
<td></td>
<td>Quick Entry</td>
</tr>
<tr>
<td></td>
<td>Pre-allocate Records</td>
</tr>
<tr>
<td></td>
<td>Mass Taxonomy Update</td>
</tr>
<tr>
<td></td>
<td>Reports</td>
</tr>
<tr>
<td></td>
<td>Lexicon (for editing)</td>
</tr>
<tr>
<td></td>
<td>Reclassify &amp; Sweep Words</td>
</tr>
</tbody>
</table>
Words to Exclude from Word Search (for editing)
User Security
Manage User Log
System Options
Software Updates
ITIS tables Update (for Natural History)
Field Properties
Public Search Configuration
Table Sharing Configuration
Create MARC records (for all archives)
Export MARC record (archives)

Data Entry
Add New Record
Copy This Record
Modify This Record
Delete This Record
Defaults & Carry Over Fields
Macros
Build Exhibit Label
Images (Import/Copy/Delete)
Multimedia (to add/edit)
Finding Aid/SGML (Archives)
Spell Check
Image Conversion
Autosave
Create MARC record (Archives)

Research
Image Zoom/Print/Properties (to view)
Image(s) View
Multimedia (to view)
Show Images in List Pane
Show only Records with Images
Update My List View
Use Large Data Navigator
Use Hierarchical Ranges (archives)
View Hierarchical Browse (archives)
Sort
First/Previous/Next/Last
Find Record
Get
Advanced Search
Advanced Filter
Deactivate Filter
Tag Functions
Global Search Results

Custom
Use this option to add or remove rights for certain functions or areas of the system. For example, you may want a user to have data entry rights in the catalog records only plus access to the Reports. This allows you to limit or expand a general right in certain areas.

Deaccession Administration
This option allows the user to Approve deaccessions.
All other functions in the program are available to all users with the exception of users who have Public Search rights only.

**Note:** The Administrator rights allow users the greatest flexibility. Users can make mass changes to records easily. However, the Administrator rights also make it very easy for the user to make mistakes on a large scale.

---

**No user should routinely work in an ICMS master database with Administrator rights. You can add specific rights to a user when needed for specific work (see below). Delete the right when the work is completed. Users with Administrator rights should have a second User ID and password that allows them to work in the system without full security rights.**

---

**7. What are the Specific Rights available and what do they allow me to do?**

Use Specific Rights to augment a general right. For example, you may want to allow access to Reports and Modify All for a Data Entry user.

<table>
<thead>
<tr>
<th>Specific Right</th>
<th>A user with this right can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restricted Information</td>
<td>add/edit/view Appraisal Supplementals</td>
</tr>
<tr>
<td>Reports</td>
<td>create/run/modify Quick Reports</td>
</tr>
<tr>
<td></td>
<td>create/run/modify Proficio Reports</td>
</tr>
<tr>
<td>Locked Tables</td>
<td>edit locked authority tables (only allowed for system designers)</td>
</tr>
<tr>
<td>Modify All</td>
<td>access Modify All Records</td>
</tr>
<tr>
<td></td>
<td>access Global Search &amp; Replace</td>
</tr>
<tr>
<td></td>
<td>access Mass Supplemental Update</td>
</tr>
<tr>
<td></td>
<td>access Mass Associations Records Update</td>
</tr>
<tr>
<td></td>
<td>access Mass Taxonomy Update</td>
</tr>
<tr>
<td>Quick Entry</td>
<td>edit records with Quick Entry</td>
</tr>
<tr>
<td>Public Search</td>
<td>access Public Search</td>
</tr>
<tr>
<td>Authority Tables</td>
<td>add/modify/delete entries in authority tables</td>
</tr>
<tr>
<td>Lexicon</td>
<td>add/modify/delete terms in the Lexicon</td>
</tr>
<tr>
<td>Edit Field Help</td>
<td>edit field specific help text on Unit page</td>
</tr>
<tr>
<td>Change Field Labels</td>
<td>change User field properties on Unit page</td>
</tr>
<tr>
<td>Circulation</td>
<td>currently not in use</td>
</tr>
<tr>
<td>Import/Export</td>
<td>import or export data</td>
</tr>
</tbody>
</table>

---

**8. What are Groups and Functions?**

The Groups and Functions fields are used to further define specific security rights for a user. The Groups field functionality is currently not used in ICMS and should be left blank. The Functions field is automatically filled in when individual Specific Rights are selected. You cannot edit this field.

---

**9. What is the Advanced Module Permissions tab?**

The Advanced Module Permissions tab allows you to further refine a user profile. You can limit access to specific modules and associated modules by checking the security option for each individually.
For example, if you want to exclude access to your accessions information
for a particular user, uncheck all options in the Advanced Module
Permissions for Accessions for that user.

Or, if you want to allow a user to only view Names and Addresses
information, check the View option only for Names and Addresses in
Advanced Module Permissions for that user.

The security options are:

- **Full**: Grants view, modify, add and delete rights to the selected
  module or associated module.

- **View**: View data and associated supplemental data with the
  exception of Appraisal Supplementals.

- **Modify**: All the rights of View plus the ability to modify records,
  add/modify supplemental records, add images and
  multimedia to records.

- **Add**: All the rights of Modify plus the ability to add new
  records.

- **Delete**: All the rights of View plus the ability to delete a single
  record.

### C. Adding a User

1. **How do I add a new user?**

   Follow these steps to add a new user:

   - Click the Add button on the button bar, *or*
• Select Add New Record from the Edit menu, or

• Press F9.

A new window will open for you to enter a new user. Follow the field-by-field instructions for completing the fields on the Main Information tab of the User Security record.

**Note:** There is no on-line screen help for these fields.

**User ID**

Enter a unique user login name for the new user.

User IDs can be no longer than 6 characters (alphanumeric only except the underscore symbol). Do not use spaces in your User ID.

Units may want to establish a system for creating User IDs, such as the user’s initials and numbers in a sequential order.

Example:  
FAH123
RPM124

**Full Name**

Enter the full name of the new user.

Names can be a combination of characters and numerals. You can enter spaces between the parts of the name.

Example: Susan R. Sarna
J. Edward Jones, Jr.

**Note:** To have the system use the user’s Windows network account to access ICMS enter the network account id in parentheses after the full name.

Example: Susan R. Sama (SRSama) 
(where “SRSama” is the Windows account id)

See Section J below for how to configure ICMS to use the Windows network accounts.

**User Type**

Enter the type of user.

Enter “Bureau User” for an employee of the Department of the Interior.

Enter “Non-Bureau User” for the following types:
  • an employee of a cooperating association
  • cataloging contractor
  • outside researcher
  • volunteer

**Set Password**

Click on the Set Password link to assign the password for the user.

**Note:** If you have configured ICMS to use the Windows network account, this password will not be used by the user when logging into ICMS. It is only associated with the ICMS User ID. They will use their regular Windows account password.
Enter a password in the New Password field. This is limited to 50 alphanumeric characters or symbols. Do not use spaces.

Then enter the same password again in the Re-enter Password field to confirm.

Then click Set Password.

2. **How do I assign security rights on the User Security Information tab?**

Click on the User Security Information tab or press Ctrl-N to access the page and assign the desired security rights for this user. This will add the user’s Global security permissions.

**Note:** To assign specific permissions within directories, you will have to save the profile first, then modify it. See Section E below. Individual directories will inherit the global security rights, unless specific directory-level security rights are assigned.

Choose the General, Specific and Advanced Module Permissions (if desired) security rights for the new user. Refer to sections B.5, B.6 and B.7 for a list of security rights and the functions available with each.

**Note:** If you want to use the default permissions for a general right, you only need to select the general right. Specific rights and Advanced Module Permissions are optional.

To choose a specific security right, make sure that there is a check in the box before the security right you wish to select. If there is not a check in the box, then click on the box and one will appear.

To remove a specific security right, make sure that there is not a check in the box before the security right you wish to remove from the user. If there is a check in the box, then click on the box and the check will disappear.

**Choose only the rights that each user needs.**

**Groups**

Leave this field blank. The Groups field is not presently used in **ICMS**.

**Functions**

Notice that as you select specific rights, this field will be populated. You cannot add to or edit this field.
3. **What is the “Use default permissions for selected general right” option?**

   Click this option to restore the default permissions for the selected option under General Rights. This is useful when you change the rights for a user so that all specific rights that may have been assigned previously are cleared and only the default permissions for the general right are activated.

4. **What is the Using Advanced Module Permissions?**

   This appears if you make adjustments to the default permissions for a General Right on the Advanced Module Permissions tab.

5. **How do I get to the Advanced Module Permissions?**

   Click on the Advance Module Permissions tab or press Ctrl-N. Use of Advanced Module Permissions is optional.

6. **How do I save the new user?**

   To save the new user record, click **Save and Close** at the bottom right.

---

### D. Viewing, Modifying and Removing Users

1. **How do I view a list of all users?**

   To view a list of all **ICMS** users, go to User Security. All users are shown in the List Pane.

2. **How do I see the full name and security rights for a specific user?**

   To see the full name and security rights for a specific user, select that user in the List Pane. The user security record will load into the Record Pane. Click on the various tabs in the Record Pane to view the main and user security information for that user.

3. **How do I change the security information for an existing user?**

   To change security information for an existing user:
   
   - Select the User ID in the List Pane that you wish to edit.
   - Select Modify this Record from the Edit menu or press F10, or click the Modify button 
     
     The record will open in a new window with Modify Mode indicated in the status bar at the lower right.
   - Make any changes desired.
   - Click **Save and Close** when finished.

   The system changes the security information for the user. A system message tells you that the changes will take effect the next time the user logs in.
4. **How do I remove a user from ICMS?**

To remove a user from ICMS:

- Select the user you wish to delete in the List Pane.
- Select Delete This Record under Delete Record(s) from the Edit menu.
- The program will ask “Are you sure you want to delete this record?” Click Yes to delete it or No to keep it.

5. **Can I view a user’s password if they have forgotten it?**

No. You cannot view user passwords. If the user does not remember their password, you can assign a new one to them.

To assign a new user password:

- Select the user in the List Pane that needs a new password.
- In the Record Pane, on the Main Information tab, click Set Password. **Note:** You do not have to be in modify mode to change the password.
- Enter a new password twice and click Set Password.
- The user can now log in with the new password.

---

### E. Directory Level Security

1. **Is there additional security available at the directory level?**

Yes. You may assign security rights for specific directories.

2. **What is the purpose of security at the directory level?**

Security at the directory level provides a way to set security on a directory-by-directory basis depending on the user’s need to work with the data. For example, a user may need to add and modify records in one directory but only need to view the records in another directory.

3. **Should I adjust users’ rights for a specific directory?**

Use the directory level security only when it is absolutely necessary. You must find the right balance between too much and too little security. Restricting users’ access too greatly places an added burden on the system administrator, as well as the users. Both the system administrator and users’ work are interrupted when the system administrator must stop to change the users’ security rights.

**Note:** Consider giving users their own “working directory” and assigning all security rights to them for that directory. When their work is accepted, it can be transferred into the master database. You can then restrict full access to the master database. Refer to Section III of this chapter for information on creating working directories.

4. **Do directory security rights override global security rights?**

Yes. Directory security rights override global security rights. For example, a user may have data entry rights at the global level but not in the natural history directory. The user will be able to enter and modify data in the cultural resources directory but not the natural history directory.
5. **How do I create separate security rights for individual directories?**

To create directory specific security rights for a user:

- Select the User ID in the List Pane for which you wish to create directory specific rights.
- Modify the record by pressing F10, or clicking the modify button or selecting Modify This Record on the Edit menu. The record will open in Modify Mode in a separate window.
- Click on the User Security Information tab.
- Select the directory from the list on the left for which you wish to set up directory specific rights.
- Once you select an individual directory, a message appears on the screen indicating that you must click Add to override the global security permissions for this directory. Individual directories will inherit the global security rights unless specific directory-level security rights are assigned. Click the Add link in the upper right.
- Update the security rights for this directory. The changes you make will only apply to the directory you selected. See B.5, B.6 and B.7 above for information on the security rights options.
- Click **Save and Close** when you have finished.

```
The best way to limit a user to a specific directory is to first add their user profile to the system with the minimum rights you want them to have in all directories. Then modify their profile and give them more rights in the directories they need to access. For example, add a user and give them Research rights overall. Then, modify their profile and add rights to their working directory assigning them Data Entry for that directory only.
```

6. **How can I tell in which directories a user has directory-specific rights?**

The directory list on the User Security Information tab shows a flag next to the directories that have specific security rights assigned for that user. All other directories will use the Global security rights.

7. **How do I view the directory specific rights?**

To view the directory-specific rights for a user:

- In the User Security List Pane, select the user you wish to view.
- In the Record Pane, click on the User Security Information tab.
- Select the directory from the list that has a flag next to it indicating that there is directory-specific security assigned.
- The directory security will be displayed.

8. **How can I change the directory specific information for a user?**

To change the directory specific security for a user:

- In the User Security List Pane, select the user you wish to edit.
9. How do I remove the directory-specific security for a user?

To remove the directory-specific security for a user:

- Modify the user profile by clicking the modify button, or selecting Modify This Record from the Edit menu. The record will open in a separate window.
- Click on the User Security Information tab
- Select the directory on the left for which you wish to modify the security rights.
- Make the needed changes to the user’s directory security information.
- Click Save and Close when finished.

A system message tells you that the changes to the user’s security will take effect the next time they log in.

F. Additional Questions About User Security

1. Can I add a user to ICMS and not check any of the security rights boxes?

Yes. If you don’t check any of the security rights boxes, and leave the general right as custom, you limit the user to Public Search only. Refer to Appendix D: Public Search, for additional information about the Public Search feature.

2. Should our unit keep the general User ID and general password that comes with ICMS?

Until you establish the same security rights for your ICMS system administrator, keep the:

- general User ID
- general password
- security rights that come with the general User ID.

Delete the general User ID, when the unit system administrator:
• is comfortable with ICMS security rules and procedures, and
• has a User ID and password with equivalent rights in place.

Note: Every ICMS system is shipped with the same general User ID and general password.

3. Should the system administrator routinely work in ICMS with full security rights?

No. Every system administrator should have two User IDs. One User ID should carry system Administrator security rights and one should not. No one should routinely work in the master database with Administrator rights.

Log in as system administrator with administrator rights only when you need them.

4. What if I lose my password and am unable to get into ICMS?

If you are… Then…

an ICMS user, ask your system administrator for help.

an ICMS system administrator, contact Re:discovery Software, Inc. for help. Their telephone number is 434-975-3256.

G. User Security Profile Report

1. What is the User Security Profile Report?

The User Security Profile Report lists each user with their security profile and what options each user’s profile contains.

2. How do I run the User Security Profile Report?

To run the report:

• Select User Security under System in the Navigation Pane.
• Click the User Security Profile Report button on the Button Bar

• A system message will ask if you want to run the report on all visible records. This report will run on the currently selected user security profile by default, but may be run for all visible records to generate a complete list of ALL security profiles in the program.

If you want to run the report on… Then…

all visible user profiles, click Yes

the currently selected user profile, click No
• The resulting report may be previewed on the screen and then sent to the printer.

• Click the printer button on the button bar or choose Print from the File menu.

H. Manage User Log

1. What is the Manage User Log tool?

   The program logs all access to the system. The Manage User Log feature allows you to manage the system-generated log of user access. The data in this file can assist in identifying errors or tracking system use.

2. How do I access the Manage User Log feature?

   To access the Manage User Log feature:
   • Select User Security under System in the Navigation Pane.
   • On the Tools menu, select Manage User Log. The Manage User Log window will open.
• Click View user log data at the bottom to load the records into the window.

3. What information is available in the User Log?

The Manage User Log window:

• indicates the number of records contained in the user log

• shows the date of the oldest entry

• lists the User ID of each person who logged into the system

• allows you to view a history of each user’s login date/time and logout date/time. **Note:** The records are initially arranged in chronological order by the Login Time – oldest to newest.

You can sort by a different column by clicking on the column header. For example, to sort the list by User ID, click on the User column header.

You can also use quick filter on the User column. Hover over the column header and click the small down arrow that appears in the upper right corner of the header. Select the User name to filter for. To clear the quick filter, click the small down arrow on the column header again and choose All. (See Section II of Chapter 7 for information on using Quick Filters.)
4. **Can I print the User Log?**

   Yes. Click the Print link at the bottom to send the list directly to the printer or click Print Preview to view the report before printing.

   From the Print Preview window, click the print button or select Print from the File menu. You can also export the document to various file formats by selecting Export Document from the File menu.

5. **What is the Purge function?**

   The purge function clears the user log of outdated records.

6. **Why would I want to purge the user log?**

   Although the user log file is small, you may need to reduce it from time to time, especially on heavily accessed multi-user systems.

7. **How do I purge the user log?**

   To purge the user log:

   - Specify a date to use for purging the file. Enter the date in the “Remove all entries…” field or click the down arrow to access a calendar and choose a date.

   - The “Save purged records” box allows you to save the purged records to an alternate directory. Check this option if you wish to save the purged records. Uncheck this option if you do not need to save the purged records.

   - Click **Purge**.

   - A message will appear asking if you are sure you want to purge the records found before the specified date. Click **Yes** to purge the records.

   - If you chose to save the purged records, a Save As window will appear for you to select a location to save the xml file. The file is named “User Log Records(\date-date\).xml” with the date range of the purged records in the file name. Click **Save** after selecting the location.

   - You will get a confirmation that the user log records were purged. Click **OK**.

   All records prior to the date you specified will be deleted from the user log.

8. **How do I exit the Manage User Log window?**

   To exit the Manage User Log window, click **Close** at the bottom right, or click the red X in the upper right corner.

## I. Audit Trail Report

1. **What is the Audit Trail feature?**

   The Audit Trail feature in **ICMS** allows you to track additions, modifications and deletions of data, as well as the user who initiated the action.

2. **What information is recorded by the Audit Trail?**

   The Audit Trail can be configured to record changes to your data at different levels. It can be set to record only that a record has been added, changed, or deleted along with the date and user id that performed the action. It can also be set to provide more detail of what field and even what data was changed in the record.

3. **Who can access the Audit Trail Report?**

   System Administrators can run the Audit Trail Report from the User Security module.
4. **How do I set up the Audit Trail feature in ICMS?**

   By default, the Audit Trail feature is turned off in **ICMS**. If you wish to track changes to your data, you will need to activate the Audit Trail in System Options.

   **Note:** You must be a System Administrator to access System Options.

   To turn on the Audit Trail:

   - On the Tools menu, select System Options
   - In the System Options Window, select the Audit Trail tab
   - There are four different levels available for the Audit Trail tracking:
     - **None:** No audit trail will be kept. (Default setting)
     - **User Level:** Each update will be recorded to the record level but no detail will be kept about what was updated.
     - **Field Level:** Each update will be recorded to the level of which fields in a record were modified but the changes to the fields will not be kept.
     - **Data Level:** Each update will be recorded for each field changed within a record with a before and after copy of the data. This level of audit trail tracking is the most detailed and requires the most disk storage space.

   Select one of the options and click **Save and Close**.

   Once the Audit Trail is set to one of the recording levels, the system will start tracking changes to your data according to the level you chose.

5. **How do I view the Audit Trail Report?**

   To view the Audit Trail Report:

   - From the Tools menu, select User Security
• Above the Navigation Pane, click the Audit Trail Report button.

• Set the date range for the records to show. The default is the past 30 days. You can click the down arrow to select the date from a calendar. Choose a starting date and an ending date.

• The “Current Audit Trail Option Setting” indicates the tracking level that is set in System Options recording changes.

• Click Show records (1000 maximum) to load the audit trail entries.

6. **What information is included in the Audit Trail Report?**

   **User Name**

   The Audit Trail Report includes the following information (depending on the level of tracking that is set):

   - The **ICMS** user id that performed the action.
| **Action** | The action that was performed on the record: Add, Modify or Delete. |
| **Date** | The date the action was performed. |
| **Computer** | The workstation from which the action was performed. |
| **Directory** | The ICMS directory where the record is located. E.g., PARK - Cultural Resources |
| **Table Name** | The associated module where the record is located. E.g., objects=Catalog Records, access=Accessions, multrel=Supplementals, etc. |
| **Record Key** | The unique key of the record that was changed. E.g., Catalog number for catalog records, Accession number for accession records, Name for Artist, etc. |
| **Field Name** | (Only recorded if tracking level set to Field Level or Data Level) The field that was changed on that record. **Note:** The field name is only recorded when the action is Modify. Adding or deleting a record does not record field by field information. |
| **Before** | (Only recorded if tracking level set to Data Level) The data that was in the field before it was edited. **Note:** only recorded if the action is Modify. |
| **After** | (Only recorded if tracking level set to Data Level) The data that is in the field after it was edited. **Note:** only recorded if the action is Modify. |

The report is listed by order of occurrence. You can sort by a different column by clicking on the column header. For example, to sort the list by User Name, click on the User Name column header.

You can also use quick filter on the columns. Hover over the column header and click the small down arrow that appears in the upper right corner of the header. Select one of the entries from that column to filter for. To clear the quick filter, click the small down arrow on the column header again and choose All. (See Section II of Chapter 7 for information on using Quick Filters.)

7. **Can I print the Audit Trail Report?**
   Yes. Click the Print link at upper right above the grid. A Preview window will open. In the Preview window, click the Print button or select Print from the File menu. You can also export the document to various file formats by selecting Export Document from the File menu.

8. **What is the Purge function?**
   The purge function clears the audit trail of outdated records.

9. **Why would I want to purge the Audit Trail?**
   You may need to reduce the size of the log from time to time, especially when the audit trail tracking is set to the Data Level or on heavily accessed multi-user systems.

10. **How do I purge the Audit Trail?**
   To purge the audit trail:
   - Click the Purge link.
Specify a starting and ending date to use for purging the file. Click the down arrow to access a calendar and choose a date for each of these.

The “Archive records to purge” box allows you to save the purged records to an alternate directory. Check this option if you wish to save the purged records. Uncheck this option if you do not need to save the purged records.

The Count records to Purge will tell you how many records are included in the date range you selected.

Click Purge records.

If you chose to save the purged records, a Save As window will appear for you to select a location to save the xml file. Enter a file name and click Save after selecting the location.

A message will appear asking if you are sure you want to purge the records selected. Click Yes to purge the records.

Click Close to return to the Audit Trail Report window.

All records within the date range you specified will be deleted from the audit trail.

J. Configuring ICMS to Use Windows Account Authentication

1. What are the options for configuring ICMS to use Windows account authentication?

There are three options for how ICMS can authenticate the user ID and password entered on the ICMS login screen. None of the options allows you to bypass the ICMS login screen. The following describes some common pros and cons of each.

- **ICMS only (standard option): start program using ICMS ID (with ICMS password)**

Users will have an id/password to remember and it often can't match other id/passwords because of limited field length.

Network log in IDs are not required, so volunteers, docents, and researchers can work in ICMS using their own User Security profiles. The profiles can be defined individually so access to features can be limited; the system can identify who modified records; and each user’s settings and preferences will be retained.
A user may have more than one login id, such as an ID for daily tasks, as well as a separate ID for advanced features.

- **ICMS or Windows network**: start program using ICMS ID (with ICMS password) or using Network ID (with network password)

  Users can start the program using either credentials. If they use their Windows network ID, they do not have to remember an extra login ID and password. Of if they use the ICMS user id, they can choose to have a shorter ID and password.

  You have the flexibility to require individual users to log in with the Windows network ID only.

  Plus the other pros and cons listed above.

- **Windows network ID only**: start program with network ID (with network password)

  Policy requirements: ID and password adhere to complexity and change requirements.

  Users have just one log in and password to remember.

  Network log in IDs are required for every user that has an ICMS ID, including volunteers, docents, and researchers. Otherwise, another employee must log into ICMS with their network ID and ICMS profile. For example, an ICMS administrator could not log into the computer and then start ICMS for a docent that does not have a network ID, even if there is a user profile for the docent in ICMS.

  Users can't have more than one ICMS security profile (for daily tasks vs. advanced features) unless they have multiple network ID’s.

2. **Do I have to create user accounts in ICMS if I configure it to use Windows account authentication?**

   Yes. Whether Proficio uses Windows authentication or Proficio authentication, all users must have a Proficio log in ID—even if the system is configured to use Windows authentication only. Proficio identifies users by their Proficio IDs. In addition to controlling access to features and certain data, Proficio uses the ID to record who modifies data or performs some tasks. It also remembers user preferences and settings.

3. **How do I set up Windows Authentication in ICMS?**

   To activate this feature:

   - Contact Rediscovery Tech Support at 434-975-3256 or support@rediscov.com to get the software update. Initially when the Windows authentication feature is activated, it is set to authenticate using Windows network security and then fall back to check ICMS user security (if there is a ICMS password).

   - Network administrators will need to create Windows network ID's for ICMS users. If you plan to restrict access so that only Windows network IDs are used, then all users will require a network ID.

   - ICMS administrators will need to configure each ICMS user id so that the network ID information is associated with the user security profile.
4. How do I set up the ICMS user accounts so that they use Windows authentication?

In User Security, add or modify a user security profile (see Sections C and D above). Note: If you are editing an existing user ID record, you are only required to adjust the Full Name field.

a) To utilize Windows authentication in ICMS, the Full Name field must have two pieces of information:

- the person's full name (this is for reference purposes)
- and, within parentheses, enter the network ID for that user

For example, SMITHAB is the network logon ID for Alberta Smith. Her ICMS user ID is ABS. The User Security record looks like this:

![User Security Record](image)

b) Password (choose one of the following options)

To allow access with ICMS credentials:
Each ICMS profile should have a password. You do not include the Windows network password in the ICMS user profile.

For a new user, click the Set Password link and assign a password. Do not use the network password.

For an existing profile, do not change the password.

To allow access with either Windows or ICMS credentials:
Each ICMS should have a password. (See above)

To restrict an individual user to using Windows network credentials only:
By leaving the password field blank for individuals, you force them to use their Windows network login ID and password.

For a new user, skip the Set Password step (or cancel the Set Password without entering a password).

For an existing user, you would remove the password. At this time, you must delete the existing user and add it again, skipping the step. There is no option for replacing an existing password with a blank.
**IMPORTANT:** It is a good idea to leave at least some of the ICMS profiles with passwords, especially the ID for the person setting this up, even if you ultimately want everyone using Windows authentication. Removing the passwords too soon impacts the ability to log in.

**To restrict all access to use Windows network credentials only**
Contact Tech Support to set the most restrictive configuration that eliminates the "fall back" of checking the ICMS login info. For new and existing users, ICMS profile passwords are ignored.

**Note:** Applying the most restrictive setting too soon may mean that you cannot log into the system without our help. This most restrictive setting should only be applied after all Proficio administrator IDs have been tested and all users have network logins, as well as updated Proficio profiles.

5. **How will users login once the system is configured to use Windows Authentication?**

Individual users will not see any difference when starting the program. After a user's ICMS user profile is configured by the ICMS Administrator, the user enters their Windows logon ID and Windows network password on the login screen.

The User ID will just be "name" not the "DOMAIN\name" that often displays when logging into the computer.

If the system is configured to allow both ICMS and Windows authentication, the user can enter either.

**Note:** Users without network ID's will need to have someone else log into the computer, but will have an individual ICMS user ID and password unless the most restrictive setting is in place.

If the **Windows login is invalid**, there may be a delay before Windows returns a rejection message.

Once a user logs into the system using either kind of authentication, the system identifies the person by the ICMS User ID. For example, the welcome screen and the Add By/ Change By information will show the ICMS ID, not the network one.
VII. SYSTEM OPTIONS

A. Overview

1. **What is System Options?**
   Use System Options to configure certain elements of the entire system and specific data directories.

2. **Do I need special security rights to use System Options?**
   Yes. System Options is available only to users with Administrator rights. See Section V of this chapter for information on User Security.

3. **When would I use System Options?**
   Use System Options to:
   - set the number of records for paging limits for large data sets
   - tell the system which directories need to share data
   - name which fields you want available in your Public Search (the portion of the program that allows public access to selected collections data)
   - set the Auto Save time interval
   - enable additional user-defined associated modules

4. **How do I access System Options?**
   System Options is accessed from the Tools menu.

B. System Level Options

1. **What are the system options on the Data Management tab?**
   The Data Management tab includes the settings for:
   - Paging
   - Auto Save time interval
   - Bulk Loading option for Sweep
   - Indexing words in multimedia files attached to records
2. **What is Paging?**

Some institutions have very large collections and as a result a single table in a directory may contain a large number of records. The software includes a way to interact with Large Data Sets that differs slightly from normal navigation. Certain features and navigation tools work a bit differently in order to optimize your use of the system.

When you have a large number of records, the system can work more efficiently when it only has to load a certain number of records at a time, in pages. Your visible data is still all records in the system, tag set, or filter, but the records are divided into pages and only one page of records is downloaded to the workstation at a time.

For more detailed information on Large Data Sets and Paging, see Section VIII of this chapter.

3. **What are the paging options I can set?**

You can set the following paging options:

- **Maximum records to retrieve before paging**
  
  This number indicates the number of records that must be in a single table (catalog records, for example) in a single directory before paging is activated. The default setting is 50,000 records. If you have more than 50,000 catalog records in one directory, then paging will be activated in catalog records in that directory. If you have only 1200 Accession records, paging will not be active there. The maximum setting available is 50,000 records. Depending on the speed of your computer and server, you may notice a slower response time when this number is set higher than 10,000.

  To change this setting, click the down arrow on the field and choose one of the number entries from the list.

- **Default number of records per page when paging**
  
  This number indicates the number of records that will load per page when paging is activated. The default setting is 10,000 records per page. If you have 60,000 catalog records in one directory, 10,000 records will be downloaded to your workstation at one time and there will be 6 pages with 10,000 records in each page.

  This is similar to searching for “museum” in an on-line search engine such as Yahoo or Google. The search may find millions of matches but it will...
present the results to you in pages so you can navigate through them a page at a time rather than making your browser load all of them at once. The maximum setting available is 50,000 records. Changes to this setting apply when you log into the program the next time or after getting a new group of records in the affected directory.

To change this setting, click the down arrow on the field and choose one of the number entries from the list.

**Default number of records to retrieve when performing a Filter or Advanced Search**

This number indicates how many records the system loads in the Search Results tab when performing an Advanced Search. When you use your search results, the system will load all records found into the main screen. For a filter, this number indicates how many records will be retrieved and loaded into the main screen. The maximum setting available is 10,000 records.

Note: This sets a default number to retrieve but you can change/override this setting on the Advanced Search and Advanced Filter screens. See Section VIII of this chapter for more information on using Advanced Search and Filter with Large Data Sets.

To change this setting, click the down arrow on the field and choose one of the number entries from the list.

4. **What is the Auto Save time interval?**

   Auto Save saves data as you type at a defined interval, to prevent data loss in the event of a power outage. If a power outage occurs while adding or modifying records, your work will be saved in a temporary file. When you restart the program, the system will notify you that a record was saved and give you options for restoring or clearing the record from memory. See Section VII of this chapter for more information on Autosave records.

5. **How do I set the Auto Save time interval?**

   On the Data Management tab in System Options, you can set the Auto Save interval from 0 to 600 seconds. At 0 seconds, Auto Save is inactive. The default Auto Save interval is set at 300 seconds (5 minutes).

6. **What is the Allow Sweep word index to use Bulk Load?**

   This option is checked by default and is recommended. It allows the Reclassify and Sweep function (see Section I in this chapter) to load the words it is indexing from your data in bulk rather than individually. This makes the sweep process complete much quicker.

7. **What is the Index words contained in recognized attached documents option?**

   ICMS has the ability to search the content of certain types of documents attached to records on the Multimedia tab using Word Search.

<table>
<thead>
<tr>
<th>If this option is set to…</th>
<th>ICMS will…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>extract and index the words in recognized document types when they are attached to records. This makes the attached documents word searchable in ICMS.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> after setting this option to Yes, you will need to run Reclassify and Sweep in each directory to index any files that were already attached to records. New files that you attach afterward will automatically be indexed for word search.</td>
</tr>
<tr>
<td>No</td>
<td>not extract words from attached documents for sweep to index. The multimedia files will not be searchable.</td>
</tr>
</tbody>
</table>
See Appendix G: Imaging and Multimedia for information on attaching documents to records.

**IMPORTANT**: If you have PDF documents already attached to records prior to setting this option to Yes, you will need to run an extract function in each directory so that sweep can index the words in the PDF files. Go to your catalog records in each directory, select the Multimedia tab (it does not matter if a file is attached to the specific record), and click the Extract Searchable Text from attached PDF Documents at the bottom right. You will need to do this once in each directory.

Then run Reclassify and Sweep on each of your directories.

8. **What types of attached documents can be searched in ICMS?**

Only text-based documents can be indexed for searching in ICMS. These are:

- Word documents (both .doc and .docx)
- Excel files (both .xls and .xlsx)
- PDF files (only text based PDF files; PDF/A files are currently not supported)
- Rich Text Format files (.rtf)
- Text files (.txt)

**Tip**: To determine if your PDF file will be searchable in ICMS, open it in Adobe Acrobat and use the Find box to search for a word you see. If it finds the word, it will be searchable in ICMS as well.

9. **What system information is on the Imaging tab?**

The Imaging tab shows how images and media files are stored and the location where the full image files are saved within the program when you attach an image to a record. It has options to divide the Full Images and Thumbnails folders into subfolders for better file management as well as apply watermarks to web images. It also indicates the version of SQL Server that you are using.

Where should images be stored?

If your ICMS is installed using SQL Server 2005 Standard Edition or higher, you have the option to store the images in an internal table in SQL instead of externally as files on the server. Your options are:
• Copy Files to Server -- copies the image file to the location specified below.

• Internal Database Table -- stores the images in an SQL database in the system.

Note: This option is grayed out for SQL Server Express Edition because file size limits may be exceeded by internally stored images. Images in SQL Server Express Edition are always stored as files on the server.

If you change this setting after images have already been attached to records, use one of the following functions to convert these existing images to the option you chose:

Copy all image files to table -- if you change the setting to Internal Database Table, use this link to import any image files that were already attached into the internal images table so they remain connected to your records. This will copy all existing images files to the internal table.

It will ask “Do you want to update duplicate images found in the Images Table with images being imported from the server location?” If you already have some images in the internal images table, clicking Yes here will update those images with those being imported if the system finds any matching ones in the server location.

Note: Copies of the images will still be located in the server location. The program will not delete them from this location.

Export all images from table to files -- if you change the setting to Copy Files to Server, use this link to export any image files that were already attached to the location indicated below so they remain connected to your records.

It will ask “Do you want to update duplicate images found in the server location with the images being exported from the Images Table?” If you already have some images in the server location, clicking Yes here will update those images with those being exported if the system finds any matching ones in the server location.

The Browse for Folder window will come up to select the FullImages and then the Thumbnails folders where images will be stored on your server.

Note: Copies of the images will still be stored in the Images Table. The program will not delete them from this table.

When image files are copied to the server, where should they be saved?

This indicates the path where image files are saved when files are copied to the server. The default setting is the location of the ICMS installation folders, for example:

C:\Program Files (x86)\Rediscovery Software Inc\Rediscovery Proficio SQL\FullImages

Or

\servername\Rediscovery Software Inc\Rediscovery Proficio SQL\FullImages

Note: You cannot change this setting.
When the “Copy Files to Server” option is used, the program will automatically divide newly attached image files into numbered subfolders (00001, 00002, etc.) within the Fullimages and Thumbnails folders. This limits the number of image files stored in each subfolder allowing for faster retrieval of image files.

The version upgrade process will not divide existing image files already in the Fullimages and Thumbnails folders.

If you already have many thousands of images attached to ICMS records, and have been using the “Copy Files to Server” option, you may want to divide existing images in the Fullimages and Thumbnails folders into subfolders. Click the Divide images in Fullimages/Thumbnails folder into subfolders link to divide the image files. The program will divide the images into subfolders as described above, and re-set the image path reference for all affected records.

These options allow you to specify the text, font, opacity, and position of a watermark for images displayed on a web site via Re:discovery’s Public Search. The image files attached to ICMS records are not changed, and the watermark is not visible within ICMS; it is only displayed via the locally installed Public Search Module.

Note: To actually alter your images with a watermark, use a photo editor such as Photo Shop to add the watermark before attaching the images to ICMS, or use the watermark options in ICMS’s Image Conversion tool (see Appendix G: Imaging and Multimedia).

An image file created in the JPEG 2000 format contains multiple resolutions of the same image, within one image file. When a JPEG 2000 image file is attached to a record, the program makes a copy of the original file (as usual), and also makes a second copy using only the resolution setting selected here. We recommend the “JPEG_QUALITYNORMAL” option. That single resolution copy is used for display in ICMS (on the Images tab of the catalog record, in reports, etc.). The full JPEG 2000 version of the image may be used if the ICMS data are displayed on a web site (via Re:discovery’s Web Module, for example), when the web site utilizes controls that can select the appropriate resolution based on the user’s input, such as when zooming in on detail.

All multimedia files attached to records will be stored as files in a “Media” folder within the Rediscovery Proficio SQL program folder. Storing multimedia files on disk avoids database file size limits with SQL Server Express edition.

You can select an alternate location to store the program’s media files. That location must be accessible to all users who will have access to ICMS’s multimedia functions (such as the ability to attach media objects to records, or to launch or play those media files). The path to the location must end with a folder named “Media.”

The Generic Table Configuration tab allows you to enable (or disable) two user-configurable associated modules and define what they are named.

Choose Yes from the pull down menu to enable one or both generic tables. After selecting Yes, the name field will be activated to allow you to enter a name for the generic table.
Note: You must restart ICMS for the associated modules to appear in the directories.

When activated, these associated modules appear in the navigation pane and each directory will have a supplemental of the same name where users can associate catalog records to the associated module records. Catalog records that have been associated with these associated module records can be seen in the Item List for the associated module records.

Users can configure the associated module screen by changing the field properties.

11. What options are on the Audit Trail tab?

The system can be set to track additions, modifications and deletions of data, as well as the user who initiated the action. The Audit Trail tab allows you to turn on and set these tracking levels.
There are four different levels available for the Audit Trail tracking:

- **None**: No audit trail will be kept. (Default setting)
- **User Level**: Each update will be recorded to the record level but no detail will be kept about what was updated.
- **Field Level**: Each update will be recorded to the level of which fields in a record were modified but the changes to the fields will not be kept.
- **Data Level**: Each update will be recorded for each field changed within a record with a before and after copy of the data. This level of audit trail tracking is the most detailed and requires the most disk storage space.

Once the Audit Trail is set to one of the recording levels, the system will start tracking changes to your data according to the level you chose.

The Audit Trail Report is run from the User Security module. See Section VI in this chapter.

**C. Client/Workstation Options**

1. **What options are available on the Client/Workstation Options tab?**

   These options allow you to establish settings that are specific to the local Proficio workstation. Currently the only available option is for setting the path to an OCR software application. The specified application can be launched while editing a record in Re:discovery, from any field’s right-click menu, by choosing the Launch OCR Software option.

   Click **Browse** to navigate to the OCR software’s application executable file.
D. Directory Options

1. What options are available on the Directory Options tab?

The Directory Options tab allows you to:

- Set table sharing between directories
- Select the fields that appear in the Public Search

2. What is Table Sharing?

Table sharing lets you share specific tables between directories. For example, you may want to share your user-built authority tables, accession file, names and addresses file, and artist file among two or more directories. This prevents the need for duplicate data entry in each directory. Choose one directory to be the master directory, where the data will actually be stored by the system. Then set table sharing for the other directories to share with the master directory.

See Sections E-G below to set up table sharing for specific directory types.

3. What is the Set Public Search Fields function?

Use this function to define which data fields are shown in the “detail” screen of Public Search for a directory. Select the specific fields and set their order with this function. The next time you use Public Search, the fields you have chosen will appear on the Detail page.

4. How do I set up the Public Search fields for a directory?

For detailed information on setting Public Search fields, refer to Section II of Appendix D, Public Search Configuration.

E. Table Sharing for Cultural Resources Directories

1. How do I establish table sharing for my Cultural Resources directory?

To set table sharing for your Cultural Resources directory:

- Open System Options from the Tools menu and select the Directory Options tab.

- Select Cultural Resources from the Directory Type list on the left
A list of your Cultural Resources directories appears on the right. Select the main Cultural Resources directory for your unit.

Click Update Table Sharing.

2. How do I set duplicate catalog number checking for Cultural Resources?

You must connect your Cultural Resources directory with your Natural History directory to enable the system to check for identical catalog numbers each time you add a new record. To set this sharing option in the window above:

- Check the “Catalog number uniqueness depends on another directory” option.
- Then select your main Natural History directory in the list that appears below this option.

The system will not allow you to save a new record with a duplicate catalog number.

3. How do I connect the Archives directory to my Cultural Resources directory?

To enable the system to transfer data from your Cultural Resources directory to your Archives directory, in the window above:

- Expand the Archives module node in the Modules box on the left by clicking the + (if necessary).
- Then click the + in front of your main archives (4-level) directory for your unit.
- Check the Collection table under the archives directory.

Click Save and Close after selecting your table sharing options.

F. Table Sharing for Natural History Directories

1. How do I establish table sharing for my Natural History directory?

To set table sharing for your Natural History directory:

- Open System Options from the Tools menu and select the Directory Options tab.
2. **How do I set duplicate catalog number checking for Natural History?**

To connect your Natural History directory with your main Cultural Resources directory for duplicate catalog number checking:

- Check the “Catalog number uniqueness depends on another directory” option.
- Then select your main Cultural Resources directory in the list that appears below this option.

The system will not allow you to save a new record with a duplicate catalog number.

3. **What other tables should I share in the Natural History directory?**

You should also select the following tables from your Cultural Resources directory for sharing:

- Expand the Collections module and then your main Cultural Resources directory by clicking the + in front of each in the Modules box.
- Check the Accessions associated module option so that the Natural History records share one accession table with the Cultural Resources records.

**Note:** Sharing the Accession table automatically shares the Exhibits, Loans Out, Loans In, and Deaccession tables.

- Check the Names and Addresses associate module so that the Natural History directory shares one Names and Addresses table with the Cultural Resources records.
- You may also want to share the Artist/Maker/Eminent Figure, Conservation, and/or Restrictions table with the Cultural Resources directory. Check these tables as desired.

**Click Save and Close after selecting your table sharing options.**
G. Table Sharing for Archives Module Directories

1. How do I establish table sharing for my 4-level Archives directory?

To set table sharing for your 4-level Archives directory:

- Open System Options from the Tools menu and select the Directory Options tab.
- Select Archives (4-level) from the Directory Type list on the left.
- A list of your 4-level Archives directories appear on the right. Select the main Archives directory for your unit.
- Click Update Table Sharing.

![Table Sharing Screen](image)

2. How do I connect my 4-level Archives directory to my Cultural Resources directory?

To connect the Archives directory to your Cultural Resources directory:

- Expand the Collections module in the Modules box by clicking the + (if necessary).
- Expand your main Cultural Resources directory.
- Check Catalog Records under the Cultural Resource directory. This enables the system to transfer Archives information to your Cultural Resources records.
- Check Accessions so that your Archives records share one accession table with the Cultural Resources directory.
- Check Artist/Maker/Eminent Figure (optional).
- Check Names and Addresses (optional).
- Click Save and Close after selecting your table sharing options.

3. How do I establish table sharing for my Item Level Archives directory?

Follow the same process for the 4-level Archives directory above.

Note: The Item Level Archives directory is optional. It provides access to an Item Level screen in the Archives Module.
H. Other Table Sharing Options

1. What if my unit manages multiple collections?

When you have finished setting up table sharing for all your unit’s directories, repeat this process for any other units or collections in your system. Follow the steps outlined in E-G above.

2. Can I share user-built authority tables between directories?

Yes. If you have well-established user-built authority tables in your main directories, you may want to share those tables with other auxiliary or working directories so that you don’t have to populate authority tables over and over again.

Note: The sharing of authority tables can only be established between the same directory type (e.g., cultural resources with cultural resources, natural history with natural history, etc.).

3. How do I set up table sharing for authority tables?

To establish table sharing for authority tables between the same directory type:

- Open System Options from the Tools menu and select the Directory Options tab.
- Select the Directory Type on the left.
- Select the auxiliary or working directory that you want to establish sharing of authority tables from your master directory.
- Click Update File Sharing
- Expand the module (Collections or Archives) that matches your selected directory.
- Expand your master directory that is the same directory type.
- Check Authority Tables. This will make the authority tables from your main directory available in this working or auxiliary directory.
- Click Save and Close when finished.

4. What other tables can I share between directories?

You may wish to share other associated module tables from your master directory as well, such as Names and Addresses and Artist/Maker/Eminent.
Figure. Check any desired. The following is a list of the associated module tables available for sharing and the directory types that can share them.

<table>
<thead>
<tr>
<th>Associated Module Table</th>
<th>Directory Where Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessions</td>
<td>Cultural Resources, Natural History (Note: Accessions is not available independently in the Archives module directories, but you can set the Archives directory to share the Accessions table from a Collection directory.)</td>
</tr>
<tr>
<td>Conservation</td>
<td>Cultural Resources, Natural History</td>
</tr>
<tr>
<td>Exhibits</td>
<td>Cultural Resources, Natural History (Note: Exhibits is included when you select Accessions)</td>
</tr>
<tr>
<td>Loans Out</td>
<td>Cultural Resources, Natural History (Note: Loans Out is included when you select Accessions)</td>
</tr>
<tr>
<td>Loans In</td>
<td>Cultural Resources, Natural History (Note: Loans In is included when you select Accessions)</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Cultural Resources</td>
</tr>
<tr>
<td>Preparation/Treatment</td>
<td>Natural History</td>
</tr>
<tr>
<td>Deaccessions</td>
<td>Cultural Resources, Natural History (Note: Deaccessions is included when you select Accessions)</td>
</tr>
<tr>
<td>Restrictions</td>
<td>All (Cultural Resources, Natural History, Archives) (Note: Restrictions cannot be shared between Collection directories and Archives directories)</td>
</tr>
<tr>
<td>Locality</td>
<td>Cultural Resources, Natural History</td>
</tr>
<tr>
<td>Artist/Maker/Eminent Figure</td>
<td>All (Cultural Resources, Natural History, Archives)</td>
</tr>
<tr>
<td>Names and Addresses</td>
<td>All (Cultural Resources, Natural History, Archives)</td>
</tr>
<tr>
<td>Generic A/Generic B (if enabled)</td>
<td>All (Cultural Resources, Natural History, Archives)</td>
</tr>
</tbody>
</table>
VIII. AUTOSAVE

A. Overview

1. What is Autosave?  
   ICMS saves your data as you work to prevent data loss in the event of a power outage. If a power outage occurs while adding, copying, or modifying records in the software, your work will be saved in a temporary file.

2. How often is my data saved in autosave?  
   Autosave is set to save your work every 5 minutes. This can be adjusted in System Options on the Tools menu. See Section VI.B of this chapter for information on changing the autosave interval.

3. How does Autosave work?  
   As you work, autosave saves your records to a temporary file at the interval specified in the System Options. When you save a record normally, the temporary file is cleared out. If a power outage occurs before you save the record, the temporary file retains a copy of the record.

   These autosave records are linked to your user ID. When you start ICMS again, the system will notify you that records were saved. Other users will not see this notification when they log in unless they have records waiting in autosave as well.

4. What kind of records are saved with autosave?  
   Any records that are in modify, copy or add mode will be saved by autosave if a power outage occurs. This includes all catalog and archive records and all associated module records.

B. Autosave Notification

1. What is the Autosave Notification?  
   The Autosave notification appears when you log in to the program and have records in a temporary file that were not saved normally.

   Note: These autosave records are linked to your User ID. Other users will not see this notification if they do not have any unsaved records in autosave.
2. **What should I do if I get this autosave notification?**

If you receive the Autosave Notification when you log in to the program, there are several actions you can take.

You can choose to:

- view the autosave records immediately by clicking **View Now**
- view the autosave records later by clicking **View Later**
- clear all the records out of autosave (for your user ID) without viewing or saving them by clicking **Clear Autosave**

**Note:** If you do not save or clear out the autosave records at this time, this notification will appear each time you log in until all records are cleared or saved.

3. **What does the View Now option do?**

View Now will open the list of records saved in autosave to allow you to find and restore any records that have not been saved. See Section C below for information on viewing autosave records.

4. **What does the View Later option do?**

View Later closes the Autosave Notification window allowing you to continue working in the program. It saves the autosave records for you to view later at a more convenient time.

5. **How can I view the autosave records later?**

To view autosave records later, choose the Autosave option on the Tools menu. Or, when you log in to the program again, the autosave notification will reappear for you to choose View Now.

**Note:** The Autosave option on the Tools menu is grayed out if no records are available in autosave.

6. **What does the Clear Autosave option do?**

Clear Autosave deletes all records in the autosave temporary file that are associated with your User ID. You do not get a chance to view the records before deletion.

You will get a message asking if you are sure you want to clear all autosave records. Click Yes to clear them or No to leave them in autosave.

---

### C. Viewing Autosave Records

1. **How do I view the autosave records?**

To view the records saved by autosave:

- Click the **View Now** option on the Autosave Notification window that you receive when you log in to the program, or
- Select Autosave on the Tools menu.

The Autosave Records window will open. The records are listed by the directory and module name. The Id will be the catalog number or unique identifier for the record such as the loan number or exhibit ID. The Name field lists another significant identifying field for that module such as object name or loan description to help you identify the record.
2. **How can I view the entire record?**

To view the entire record:

- Highlight the record in the list you wish to view.
- Click View on the bottom left.

The full record will open in a new window. The title bar on the record window will indicate that it is an autosave record.

3. **How do I save the autosave record?**

When you open an autosave record, there are several options for saving it depending on what mode you were in when the power outage occurred.

**If you cancel or close the autosave record at any point without saving, it will be cleared from the autosave list and cannot be retrieved again.**

<table>
<thead>
<tr>
<th>If you were in…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or Copy mode,</td>
<td>the record will open in Modify mode and allow you to save it as a new record. Click Save and Close to save the record.</td>
</tr>
<tr>
<td>Modify mode and that record was not modified again later,</td>
<td>the autosave record will open in Modify mode and allow you to save it, replacing the original record. When you click Save and Close, a message will appear asking if you want to replace the original record with the one from autosave. Click Yes to replace it.</td>
</tr>
<tr>
<td>Modify mode and the existing record was more recently edited than the autosave record,</td>
<td>you will get a message that a more recently modified copy of this record exists and have the opportunity to open both records to compare them.</td>
</tr>
</tbody>
</table>
If you click… the program will…

Yes, open the autosave record in Modify mode while the more recently modified record will open in View mode. You can compare the data and copy information from the more recently modified record into the autosave record using copy and paste options, if desired.

Note: You cannot copy data from the autosave record to the existing record since it opens in View Mode only and cannot be edited.

No, open only the autosave record in Modify mode.

If you save the Autosave record at this point, you will get a message asking if you want to replace the more recently modified record.

- Click Yes to save the Autosave record replacing the more recent record.
- Click No to not overwrite the more recent record. You will be returned to the Autosave record which will still be in modify mode. You can then Cancel the record, which will clear it from autosave.

4. How do I delete the autosave record without saving it?

If you do not want to save the record that is in autosave:

- highlight the record in the list and click Clear at the bottom of the Autosave Records window, or
- if you have the entire record open, click Cancel and the record will be removed from autosave.

You will get a message asking if you are sure you want to clear the autosave record without saving it. Click Yes to clear it.

5. Can I clear all the records in the list at once without saving them?

Yes. If you do not want to save any records in the autosave list, click Clear All in the Autosave Records window. You will get a message asking if you are sure you want to clear all records from autosave. Click Yes to clear them all, or No to return to the list.
6. **How do I exit from the Autosave Records list?**

To exit the Autosave Records window, click **Close**. Any records that have not been cleared will remain in the list and you will get a notification the next time you log in.

7. **Can I view autosave records logged by another user?**

No. Only the User ID that logged the autosave record can view the autosave records.

---

**D. Other Features of Autosave**

1. **What happens if I modify a record that also has an autosave record waiting?**

If another user was modifying a record when a power outage occurred and the record was saved in autosave, you (as a different user) will not see the autosave notification. Therefore, you could modify the same record before it is retrieved from autosave.

If a user tries to modify a record that has an entry in autosave, they will get the following message to alert them that there is an updated version waiting in autosave. The user ID who has the record in autosave will be indicated. Only that user can save or clear the record from the autosave list.

- Click **Yes** to modify the record anyway. When the autosave entry is opened later, there will be an option to compare the two records as described above.

- Click **No** to cancel the modify. You or the user who has the record in autosave can then restore it or clear it as necessary.
IX. LARGE DATA SETS AND PAGING

A. Overview

1. **What are Large Data Sets?**
   Some institutions have very large collections, and as a result a single table in a directory may contain a large number of records. The software includes a way to interact with Large Data Sets that differs slightly from normal navigation. Certain features and navigation tools work a bit differently in order to optimize your use of the system.

2. **What is Paging?**
   When you have a large number of records, the system can work more efficiently when it only has to load a certain number of records at a time, in pages. Your visible data is still all records in the system, Tag Set, or Filter, but the records are divided into pages and only one page of records is downloaded to the workstation at a time.

3. **How do I know if I need to use Paging?**
   If a single table in any directory (such as catalog records) is larger than 50,000 records, that table will use Paging. **50,000 is the maximum number of records the system will return before activating Paging.**
   If your system seems slow to populate the List Pane and Record Pane, you may want to adjust the Paging limit to a lower number than 50,000, so that the records are downloaded and available more quickly.

4. **How will Paging affect the use of records in a directory?**
   With Paging activated, the system will only download the maximum number of records into the List Pane as specified in the Paging settings defined in System Options.
   What this means is that if you have 65,000 catalog records in a single directory and the maximum number of records to retrieve before Paging is set at 50,000 records, Paging will be activated. The 65,000 records will be divided into pages of a specified number per page. For example, you may have a setting of 5,000 records per page when Paging is activated, so your 65,000 catalog records will be divided into 13 pages of 5,000 records each.
   Paging is only activated for the table that exceeds the maximum records setting. In the same directory as the 65,000 catalog records example above, if you access an associated module such as Accessions that has only 8,000 records, Paging will not be activated for that table. All 8,000 records will be downloaded to the workstation.
   You will still be able to search the entire directory regardless of how many records are currently downloaded.
   **This is similar to searching for “museum” in an on-line search engine such as Yahoo or Google. The search may find millions of matches but it will present the results to you in pages so you can navigate through them a page at a time rather than making your browser load all of them at once.**

5. **Can I set how many records are downloaded per page?**
   Yes. The user can control some Paging settings such as how many records must be in a database before Paging is activated and how many records are loaded into each page. These settings appear in System Options on the Tools menu and are located on the Data Management Tab under System Level Options. These settings are system wide and will apply to all workstations.
6. **What features are affected by Paging?**

   The features that work a bit differently when Paging is activated are:
   
   - Quick Search
   - Quick Filter
   - Quick Sort
   - Advanced Search
   - Advanced Filter
   - Print List and Preview List
   - Export List
   - Grouping
   - My List View

   Refer to the sections below for information on how these features work when Paging is activated.

B. **Large Data Set and Paging Settings**

1. **How do I change the Large Data Set and Paging settings?**

   To change the Large Data Set and Paging settings:

   Select System Options on the Tools menu. **(Note: You must have Administrator rights to access System Options.)**

   The Paging settings are on the Data Management tab of the System Level Options page.

   ![System Options Window](image)

   The system default setting for the maximum number of records in a directory before Paging is activated is 50,000. This is also the maximum setting available. Depending on the speed of your computer and server, you may notice a slower response time when this number is set higher than 10,000.

   To change this setting to a lower number in the Systems Options window, click the down arrow on the “Maximum records to retrieve before Paging” field. Changes to this setting apply when you log into the program the next time or after getting a new group of records in the affected directory. Your choices are:

   - 500
3. What is the “Default number of records per page when Paging” setting?

The “Default number of records per page when paging” number indicates the number of records that will load per page when Paging is activated. The system default is set at 10,000 records per page.

To change this setting to another number in the Systems Options window, click the down arrow on the field. Your choices are:

- 100
- 200
- 500
- 1000
- 2000
- 5000
- 10000
- 20000
- 50000

Using the setting of 10,000, for example, if you have more than 10,000 catalog records in one directory, then Paging will be activated in Catalog Records in that directory. If you have only 8,000 accession records, Paging will not be active there.

4. What is the setting for records to return when using Filter or Advanced Search?

The “Default number of records to retrieve when performing a Filter or Advanced Search” number indicates how many records the system loads in the Search Results tab when performing an Advanced Search. However, when you use your search results, the system will load all records found into the main screen. For a Filter, this number indicates how many records will be retrieved and loaded into the main screen. The maximum setting available is 10,000 records.

To change this setting to a lower number in the Systems Options window, click the down arrow on the field. Your choices are:

- 500
- 1000
- 2000
- 5000
- 10000

Note: This sets a default number to retrieve but you can change/override this setting on the Advanced Search and Advanced Filter screens. See sections D and E below for more details on using Advanced Search and Filter with Large Data Sets.
C. Large Data Set Navigation

1. How do I navigate through the pages when Paging is activated?

A Large Data Navigator is available to the user to make viewing and navigating large data sets easier.

2. Do I have to use the Large Data Navigator when Paging is activated?

No, you do not have to use the Large Data Navigator when Paging is activated. However, if the Large Data Navigator is not active, then the system will download only the top number of records as set in the System Options (2000 records in the example above) without a way to navigate to other records.

Most of the time, using the Large Data Navigator will be the most flexible and efficient way to navigate large data sets. You will still have access to most commonly used features, Sorts, My List View, Reports, Search, and Advanced Filter.

3. When would I not want to use the Large Data Navigator?

The best time to not use the Large Data Navigator is when you have a Tag Set containing fewer records than the number of records per page setting and you want to use Quick Sort, Quick Filter, or Grouping in the List Pane.

4. How do I turn on the Large Data Navigator?

When viewing records where Paging is activated, turn on the Large Data Navigator by checking the “Use Large Data Navigator” option on the View Menu.

The Large Data Navigator will appear above the List Pane and displays the number of records in your visible data and number of pages. The number of records currently loaded still appears in lower right in the Status Bar.

5. What does the Total Records number indicate in the Large Data Navigator?

Total Records is the number of records in your visible data, Tag Set, or Filter.

If you want to know how many records are loaded per page, look at the number in the status bar at the bottom right corner of the page.

Note: If you use shift-click or control-click to select multiple records in the list pane, the number of records in your visible data is now the number that appears in the Status Bar and any action such as running reports or transfer
will only affect those selected records.

6. **How do I move through the pages of records when Paging is activated?**
   First, make sure that the Large Data Navigator is turned on (go to View → Large Data Navigator). Then, to move from one page to another when Paging is activated:
   - Click **Next >>** in the Large Data Navigator to move to the next page of records
   - Click **<< Previous** in the Large Data Navigator to move to the previous page of records

7. **How do I jump to a specific record when Paging is activated?**
   Make sure that the Large Data Navigator is turned on. Then, to go to a specific record in your data based on the sort order, use the **Get** option on the button bar or Record menu or press F8.
   After entering the catalog number or term for the record you want, the program will jump to that record in the list no matter what page it is on.

8. **How do I return to the very beginning of my records?**
   To return to the beginning of your records (based on the sort order), click page number 1 in the Large Data Navigator.

9. **Why do the First Record and Last Record functions not go to the very beginning or end of my data?**
   The First Record and Last Record functions on the button bar or on the Record menu only apply to the current page of data.
   For example, if you are on page 3 of your data when Paging is activated, the First Record button will only take you to the top of page 3 and the Last Record button will only take you to the bottom of page 3 of your data.

   To advance to other pages, use the Large Data Navigator’s Next and Previous links. Or use the Get function as described in C.7 above.

10. **Can I use Quick Sort when Paging is activated?**
    Quick Sort works differently when Paging is activated.

    **If the Large Data Navigator is...**
    **Then...**
    
    Active  
    you cannot use Quick Sort to resort the data by a specific column in the List Pane.
    
    Not Active  
    you can use Quick Sort in the List Pane, but it only applies the sort to the current page of records.

    This feature is best used for an active Filter or Tag Set containing fewer records than the “Maximum records to retrieve before Paging” setting in System Options.

    **Note:** If you want to change the sort order for the entire table, you must use the Sorts on the button bar or under the Sort option on the Record menu.
11. How is My List View affected by Paging?

When creating a My List View sort option, you can still select which fields to be displayed in the list view. However, instead of selecting which individual fields to sort the records, you will need to use one of the standard sorts that appear in the list on the Button Bar or under the Sorts option on the Record Menu.

![My List View](image)

To select the sort option in My List View for large data sets:

- Select Update My List View from the View menu.
- Select the Order Results By tab
- Under “When using large sets of data use this sort...”, click the down arrow on the field and choose the sort order you want My List View to use.
- For Get to work in the Large Data Navigator for the My List View sort, you must also select the same field that the sort uses from the Column Pick List and add it to the Columns to Sort By. **Note:** There can be only one field in the Columns to Sort By list for large data sets.

12. Can I use Grouping when Paging is activated?

Grouping works differently when Paging is activated.

**If the Large Data Navigator is...**

<table>
<thead>
<tr>
<th>Active</th>
<th>you cannot use Grouping in the List Pane.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Active</td>
<td>you can use Grouping in the List Pane, but the grouping only applies to the current page of records.</td>
</tr>
</tbody>
</table>

This feature is best used for an active Filter or Tag Set containing fewer records than the “Maximum records to retrieve before Paging” setting in System Options.
D. Filtering Large Data Sets

1. Can I use Quick Filter when Paging is activated?

Quick Filter works differently when Paging is activated.

*If the Large Data Navigator is... Then...*

- **Active**
  - you cannot use Quick Filter to filter the data in the List Pane.

- **Not Active**
  - you can use Quick Filter in the List Pane, but it applies the filter to the current page of records only.

This feature is best used for an active Filter or Tag Set (small data set) containing fewer records than the “Maximum records to retrieve before Paging” setting in System Options.

**Note:** If you want to filter for records in the entire table, you must use the Advanced Filter.

2. How do I use Advanced Filter with Large Data Sets and Paging?

Advanced Filter 📊 on the Button Bar or Record Menu contains 2 settings related to Large Data Sets and Paging.

- Limit Records Returned To
- Order Results By

3. What is the Limit Records Returned To setting?

The “Limit Records Returned To” setting on the Filter Criteria tab is set by default to the “Default number of records to retrieve when performing a Filter or Advanced Search” setting in System Options.

*If the number of records found that match an Advanced Filter is... then...*

- less than the “Limit Records Returned To” setting
  - all of the records will be downloaded to the workstation and appear in the List Pane.

- less than the “Maximum records to retrieve before Paging” setting in System Options,
  - The total number of records will appear in the Status Bar.
less than the “Limit Records Returned To” setting AND
more than the “Maximum records to retrieve before Paging” setting in System Options,

Paging will be active. The total number of records found that match the Advanced Filter will appear next to Total Items in the Large Data Navigator (if active) as will the number of pages of results.

more than the “Limit Records Returned To” setting,

only that number of records will be downloaded to your workstation and appear in the List Pane. In this case, not all of the records that matched the Advanced Filter will be in your visible data.

more than the “Maximum records to retrieve before Paging” setting in System Options AND the “Limit Records Returned To” is set at “Greater than 10000,

Paging will be active. The total number of records found that match the Advanced Filter will appear next to Total Items in the Large Data Navigator (if active) as will the number of pages of results. The number of records in the current page will appear in the lower right in the Status Bar.

4. Can I change the default setting from the Advanced Filter window?

Yes. To change the default setting for the number of records returned, select an entry from the drop down menu. Your options are:

- 10
- 20
- 50
- 100
- 200
- 500
- 1000
- 2000
- 5000
- 10000
- Greater than 10000

5. How do I order the results of a filter when using large sets of data?

When you create an Advanced Filter, you have the option of choosing a field to sort the results by from the Advanced Filter window. When Paging is activated on large data sets, instead of selecting which individual fields to sort the filtered records, you will need to use one of the standard sorts that appear in the list on the Button Bar or under the Sorts option on the Record Menu.
To select the sort option for an Advanced Filter for large data sets:

- In the Advanced Filter window, after creating your filter criteria, click on the Order Results By tab.

- Under “When using large sets of data use this sort...”, click the down arrow on the field and choose the sort order you want the filter results to use.

- For Get to work in the Large Data Navigator for the filter results sort, you must also select the same field that the sort uses from the Column Pick List and add it to the Columns to Sort By. **Note:** There can be only one field in the Columns to Sort By list for large data sets.

**E. Searching in Large Data Sets**

1. **Can I use Quick Search with Large Data Sets?**
   
   Yes. Quick Search will search for the term you enter in all records in your data including large data sets.

2. **How are the Quick Search results affected by large data sets?**
   
   The results of a Quick Search are affected depending on the number of records found that contain the search term.

   - If the number of records found that match a Quick Search is less than the “Maximum records to retrieve before paging” setting in System Options, all of the records will be downloaded to the workstation and appear in the list pane. The total number of records will appear in the lower right in the Status Bar. (No Paging is activated.)

   - If the number of records found that match a Quick Search is more than the “Maximum records to retrieve before Paging” setting in System Options, Paging will be active. The total number of records found that match a Quick Search will appear next to Total Items in the Large Data Navigator (if it is active) as will the number of pages of results. The number of records in the current page will appear in the lower right in the Status Bar.

3. **How do I use Advanced Search with Large Data Sets and Paging?**

   Advanced Search on the Button Bar or Record Menu contains a Limit Records Returned To setting related to Large Data Sets and Paging.
4. **What is the Limit Records Returned To setting in Advanced Search?**

Limit Records Returned To determines how many records are loaded into the Search Results tab of the Advanced Word Search window. It is set by default to the “Default number of records to retrieve when performing a Filter or Advanced Search” setting in System Options.

When you launch an Advanced Search, the Search Results tab will show you how many records found that matched the search and it will load the number of records in the “Limit Records Returned To” in the grid. This shows you a sample of the records found that match the search.

![Advanced Word Search window](image)

**Note:** Notice above that the search found 73 records, but only 50 are displayed in the Search Results List. The Limit Records Returned To was set at 50 in this example.

5. **Can I change the Limit Records Returned To setting?**

Yes. To change the default setting for the number of records returned, select an entry from the drop down menu. This is the number of records that will be loaded on the Search Results tab. Your options are:

- 10
- 20
- 50
6. Can I view all records found in an Advanced Search if the results exceed the number in the Limit Records Returned to setting?

Yes. The Limit Records Returned To setting only affects the records loaded into the Search Results tab. When you click Use Search Results after performing an advanced search, all records found will become your visible data.

The Tag Set created from the search may have Paging activated depending on the following:

- If the number of records found that match an Advanced Search is less than the “Maximum records to retrieve before Paging” setting in System Options, all of the records will be downloaded to the workstation and appear in the list pane. The total number of records will appear in the lower right in the Status Bar.

- If the number of records found that match an Advanced Search is more than the “Maximum records to retrieve before Paging” setting in System Options, Paging will be active. The total number of records found that match an Advanced Search will appear next to Total Items in the Large Data Navigator (if it is active) as will the number of pages of results. The number of records in the current page will appear in the lower right in the Status Bar.

F. Other Functions Affected by Large Data Sets

1. How is the Print List and Preview List affected by Large Data Sets and Paging?

Print List and Print Preview on the Button Bar and File Menu will only print the records as they appear in the list pane for the number of records in the currently viewed page. The number of records in the page appears in the lower right of the Status Bar.

If you want to print the list for the other pages of records, you will have to navigate to the additional pages using the Large Data Navigator options and print them separately.

2. How are the Export List options affected by Large Data Sets and Paging?

The Export List choices under Import/Export on the File Menu will only export the records as they appear in the list pane for the number of records in the currently viewed page. The number of records in the page appears in the lower right of the Status Bar.

If you want to export all the visible records, you will have to navigate to the additional pages using the Large Data Navigator options and export them separately.
X. SOFTWARE UPDATES & WORKSTATION SYNCHRONIZATION

A. Overview

5. What is Software Updates? Software Updates allows you to apply program updates that will be provided periodically by Re:discovery Software Inc. It lists any updates that have been applied to your system or may be pending.

6. When would I use Software Updates? You will use Software Updates when you receive a program update zip file and instructions from Re:discovery Software Inc.

You may also use Software Updates to install the Public Search component of ICMS. See Appendix D for information on installing Public Search.

Note: You can also use Software Updates to load a backup zip file of a data directory.

7. What is Workstation Synchronization? When a software update has been applied to your server, each workstation will be required to synchronize the program with the server. This ensures that the workstations have the same updates as the server.

B. Applying Software Updates

3. How do I access Software Updates? To access the Software Updates function:

• Go to the Tools menu.

• Select Software Updates.

Note: If the Software Updates option is grayed out, your login name does not have the correct security rights to access this function.

You will see the Software Updates screen.

All systems include the RediscoveryProficioPublicSearchVersion8-10.zip update file. This is used for installing the Public Search component of ICMS, if desired. The status will always show “Pending”. See Appendix D for Public Search installation information.
4. **How do I install a software update?**

Choose one of the steps below to install a software update:

- If a Software Update Zip File is listed with a status of Pending, select that update and click Install in the Action column.

- If you have received an update zip file from Re:discovery Software Inc that is not listed here and you copied it to your computer, locate that zip file by clicking the Browse link and navigating to the location where you saved the zip file. Once selected, click Install and the update will be applied.

- If you are loading a backup zip file of a directory, locate that zip file by clicking the Browse link and navigating to the location where you saved the zip file. Once selected, click Install and the backup will be loaded.

**Note:** Depending on the type of update being applied, it may require that you close the program before it can be completed.

5. **How do I synchronize the workstations?**

When you start the system on your workstation for the first time after an update has been applied to the server, you will see the following message indicating that you must synchronize your workstation with the server before you can use the program.

![Synchronization Message]

Click Yes to synchronize the workstation now. Otherwise, you will not be able to use the program until the synchronization has occurred.

![Synchronization Process]

Please wait while the synchronization process completes on your workstation. When finished, the regular login screen will appear for you to log in and use the program with the new updates applied.

6. **What is the Activate Software link?**

The Activate Software link is used to apply new product codes to turn features on or off. You will not use this in ICMS.

7. **What is the Synchronize Workstations link?**

Use the Synchronize Workstations link to force all workstations to synchronize with the server version of ICMS. All workstations will synchronize with the server the next time they are started (see 3 above).

**Note:** Applying new software updates to the program will automatically trigger the workstation synchronization.
8. *What is the Email Upgrade/Patch Log?* When you apply an update to your system, you can let us know by clicking the Email Upgrade/Patch Log link at the bottom right. This is optional and will send us only the log of the updates applied to your system.